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●{ About the Product Warranty

Every effort has been made to ensure that the information in this document is complete, accurate, 
and up-to-date. The manufacturer assumes no responsibility for the results of errors beyond its 
control. The manufacturer also cannot guarantee that changes in software and equipment made by 
other manufacturers and referred to in this guide will not affect the applicability of the information 
in it. Mention of software products manufactured by other companies does not necessarily constitute 
endorsement by the manufacturer.

While all reasonable efforts have been made to make this document as accurate and helpful as 
possible, we make no warranty of any kind, expressed or implied, as to the accuracy or completeness 
of the information contained herein.

All rights are reserved by Oki Data Corporation. You must not copy, transfer, translate, etc. the content 
herein without authorization. You must obtain written permission from Oki Data Corporation before 
doing any of the above.

© 2012 Oki Data Corporation

OKI is a registered trademark of Oki Electric Industry Co., Ltd.

Energy Star is a trademark of the United States Environmental Protection Agency.

Microsoft, Windows, Windows Server and Windows Vista are registered trademarks of Microsoft 
Corporation.

Apple, Macintosh, Rosetta, Mac and Mac OS are registered trademarks of Apple Inc.

Other product names and brand names are registered trademarks or trademarks of their proprietors.

As an Energy Star Program Participant, the manufacturer has determined that this product meets the Energy Star guidelines for energy eficiency.

This product complies with the requirements of the Council Directives 2004/108/EC (EMC), 2006/95/
EC (LVD),1999/5/EC (R&TTE), 2009/125/EC (ErP) and 2011/65/EU(RoHS), as amended where 
applicable, on the approximation of the laws of the member states relating to Electromagnetic 
Compatibility, Low Voltage, Radio & Telecommunications Terminal Equipment, Energy related 
Products and Restriction on the use of certain Hazardous Substances in electrical and electronic 
equipment.

The following cables were used to evaluate this product to achieve EMC directive  2004/108/EC compliance and conigurations other than this may affect that compliance.

cable type
length 

(meters)
core shield

Power 1.8 ✘ ✘

USB 5.0 ✘ ✔

LAN 15.0 ✘ ✘
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●{ Emergency irst aid
Take care with toner powder:

If swallowed, give small amounts of cold water and seek medical attention. DO 
NOT attempt to induce vomiting.

If inhaled, move the person to an open area for fresh air. Seek medical attention.

If it gets into the eyes, lush with large amounts of water for at least 15 minutes 
keeping eyelids open. Seek medical attention.

Spillages should be treated with cold water and soap to help reduce risk of 
staining skin or clothing.

●{ Manufacturer

Oki Data Corporation, 
4-11-22 Shibaura, Minato-ku, 
Tokyo 108-8551, 
Japan

For all sales, support and general enquiries contact your local distributor.

●{ Importer to the EU/Authorized representative

OKI Europe Limited (trading as OKI Printing Solutions)

Blays House 
Wick Road 
Egham 
Surrey, TW20 0HJ 
United Kingdom

For all sales, support and general enquiries contact your local distributor.

●{ Environmental information
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●{ For Your Safety

Read the User’s Manual for your safety before using the product.

Cautions related to safety

WARNING
A warning provides additional information which, if ignored, may result in a risk of personal 
injury.

CAUTION
A caution provides additional information which, if ignored, may result in equipment 
malfunction or damage.

General cautions

WARNING

Do not touch the safety 
switch inside the printer. 
Doing so may cause electric 
shock when high voltage 
occurs. In addition, the 
rotating gears may result in 
injury.

Do not use highly lammable 
sprays near the printer. Doing so may cause ire as parts of 
the printer are hot.

Unplug the power cord 
and contact a customer 
service center if the cover 
is unusually hot, smoking, 
giving off an unusual odor, 
or making strange noises. 
Failure to do so may lead to a ire.

Unplug the power cord and 
contact a customer service 
center if a liquid such as 
water enters in the internal 
parts of the printer.
Failure to do so may lead to a ire.

Unplug the power cord and 
remove foreign materials 
such as paper clips if they 
fall inside the printer. Failure 
to do so may cause electric shock and/or ire, leading to 
injuries.

Do not operate and/or 
disassemble the printer other 
than as directed in User’s 
Manual. Doing so may cause electric shock and/or ire, 
leading to injuries.

Unplug the power cord 
and contact a customer 
service center if the printer 
is dropped or the cover is 
damaged.
Failure to do so may cause electric shock and/or ire, 
leading to injuries.

Unplug the power cord 
periodically to clean plug 
blades and base section 
between the blades.
If the power plug remains 
inserted for a long time, the 
base section will get dusty, 
and the plug may short circuit, which may cause ire.

Do not clean spilled toner 
with a vacuum cleaner.
If cleaning spilled toner with 
a vacuum cleaner, it may catch ire due to the sparks 
from electric contact.Toner spilled on the loor 
should be wiped off with wet 
cloth.

Do not insert materials in a 
vent hole.
Doing so may cause electric shock and/or ire leading to 
personal injuries.

Do not put a cup with liquids 
such as water on the printer.
Doing so may cause electric shock and/or ire leading to 
personal injuries.

Do not touch the fuser and 
other parts when opening the 
cover of the printer.
Doing so may cause burns.

Do not throw toner cartridges 
and image drum cartridges into ire. Doing so may cause 
dust explosion leading to 
burns.

Do not use a power cord, a 
cable, or a ground wire other 
than those that are indicated 
in User's Manual.Doing so may cause ire.

The operation of using UPS 
(uninterruptible power 
source) or inverters is not 
guaranteed. Do not use 
uninterruptible power source 
or inverters.Doing so may cause ire.

CAUTION

Do not come closer to the paper’s exit area 
when the power is turned on, while printing.
Doing so may result in personal injury.

Do not touch a damaged liquid-crystal display.
If liquid (liquid crystal) leaked from the liquid-crystal display gets into the eyes or mouth, lush 
with large amount of water. Follow the direction 
from a doctor if necessary.
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●{ Manual Composition

The following manuals are included with this product.

 { Quick Guide

This notes brief descriptions of how to install this printer.

 { User’s Manual (Setup) ---- This document

Basic operations are described to aid understanding of this printer. The initial setup descriptions 
including printer placement and the network initial setting are noted along with troubleshooting and 
maintenance procedures.

 { User’s Manual (Advanced)

The advanced manual describes the advanced operations of each function. The utility and network 
setting information is included.

●{ About This Manual

Terms in this document

The following terms are used in this manual.

Note

 { Indicates important information on operations. Make sure to read sections with this mark.

Memo

 { Indicates additional information on operations. You should read sections with this mark.

Reference

 { Indicates where to look when you want to know more detailed or related information.

WARNING

 { A warning provides additional information which, if ignored, may result in a risk of personal injury.

CAUTION

 { A caution provides additional information which, if ignored, may result in equipment malfunction or 
damage.

Symbols in this document

The following symbols are used in this manual.

Symbols Description

[  ]  { Indicates menu names on the display screen.
 { Indicates menu, window, and dialog names on the computer.

"  "  { Indicates messages and input text on the display screen.
 { Indicates ile names on the computer.
 { Indicates reference titles.

<  > button/key Indicates a hardware button on the operator panel or a key on the keyboard of the 
computer.

> Indicates how to get to the item you want in the menu of this printer or the computer.

Your Printer Indicates a printer you want to use or select.
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Notation used in this manual

The following notations may be used in this manual.

 { C831n/C831dn→ C831

 { C841n/C841dn→ C841

 { PostScript3 Emulation→ PSE, POSTSCRIPT3 Emulation, POSTSCRIPT3 EMULATION

 { Microsoft® Windows® 7 64-bit Edition operating system→ Windows 7 (64bit version) *

 { Microsoft® Windows Vista® 64-bit Edition operating system→ Windows Vista (64bit version) *

 { Microsoft® Windows Server® 2008 R2 64-bit Edition operating system→ Windows Server 2008 *

 { Microsoft® Windows Server® 2008 64-bit Edition operating system→ Windows Server 2008 (64bit version) *

 { Microsoft® Windows® XP x64 Edition operating system → Windows XP (x64 version) *

 { Microsoft® Windows Server® 2003 x64 Edition operating system→ Windows Server 2003 (x64 version) *

 { Microsoft® Windows® 7 operating system→ Windows 7 *

 { Microsoft® Windows Vista® operating system→ Windows Vista *

 { Microsoft® Windows Server® 2008 operating system→ Windows Server 2008 *

 { Microsoft® Windows® XP operating system→ Windows XP *

 { Microsoft® Windows Server® 2003 operating system→ Windows Server 2003 *

 { Microsoft® Windows® 2000 operating system→ Windows 2000

 { Generic name for Windows 7, Windows Vista, Windows Server 2008, Windows XP, Windows Server 2003, and 
Windows 2000→ Windows

*   If there is no special description, 64bit version is included in Windows 7, Windows Vista, Windows Server 2008, 
Windows XP, and Windows Server 2003. (64bit version and Windows Server 2008 R2 is included in Windows 
Server 2008.)

If there is no special description, Windows 7 is used as Windows, Mac OS X 10.6 is used as Mac OS X, and C831dn 
is used as the printer for examples in this document.

Depending on your OS or model, the description on this document may be different.
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1. Setup
How to set up is explained in this chapter.

 � Setup Flow

1. Checking Products

 { Checking package contents
 { Checking names of the operator panel and how to 
operate 

 { Checking names of product parts
 { Checking options

2. Checking the Placement Environment

 { Checking the placement environment
 { Checking placement location

3. Preparing a Printer

 { Unpacking
 { Removing cushioning materials
 { Installing consumables
 { Loading paper
 { Turning on/off the power
 { Installing options
 { Test printing from the printer

4. Connecting to a Computer

Connecting through network Connecting through USB

For Windows For Macintosh For Windows For Macintosh

Connecting through 
EtherTalk

Connecting 
through Bonjour

Specifying an IP address 
on the operator panel

Enabling EtherTalk on the 
operator panel

Disabling the sleep mode on the operator panel Connecting a cable

Connecting a cable

Installing a printer driver on a computer

Adding printers on a computer Connecting a 
cable

Adding printers on a 
computer

Enabling the sleep mode on the operator panel

Test printing from a computer
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●{ Checking Products

This section gives an overview of the printer.

Checking Package Contents

Check that you have everything shown below.

CAUTION It may cause injury!

 { At least two people are needed to lift the printer 
safely because it weighs about 37 Kg or 40 Kg.

Reference

 { For details on how to open the package, refer to 
“Unpacking” P.17.

 { Printer

 { Four image drums (black, yellow, magenta 
and cyan)

 { Four starter toner cartridges (black, yellow, 
magenta and cyan)

Note

 { The starter toner cartridges are installed in the 
image drums which are installed in the printer before 
shipment.

 { Louver for emission

 { Quick Guide

 { Software DVD-ROM

 { AC cord

Note

 { An Ethernet cable and USB cable are not supplied with 
your printer. Procure them separately.

 { Packaging and cushioning material are needed if 
transporting the printer. Do not throw them away.
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●{ Operator Panel

This section explains the names and functions of components on the operator panel and how to enter 
text.

1

34

5

567

8

12

13 10

11

9

2

No. Name Function

1 Display screen Displays operating instructions and the status of the printer.

2 <ON LINE> button Switches between on line and off line modes.

3 <CANCEL> button Cancels the current print immediately.

4 <ENTER> button  { Displays the menu screen.
 { Conirms the highlighted item.

5 <SCROLL> button Selects the menu or scrolls the screen.

6 <BACK> button Returns to the previous screen.

7 <HELP> button Displays the help screen. To close, press the <HELP> button, <BACK> 
button, or <CANCEL> button.

8 <POWER SAVE> button  { Enters or exits the power saving mode.
 { Exits the sleep mode.

Lights up green in the power save mode and blinks green in the sleep mode.

9 Ten-key pad  { Enters numbers.
 { Enters alphabetical characters and symbols.

A password can be entered only with a ten-key pad.

10 <Fn> key Displays the equipment setting menu screen with a shortcut function.

11 <CLEAR> key Executes the following actions according to the entered items when pressed 
or held down.

 { Minimizes a setting value.
 { Enters zero for a setting value.
 { Deletes a character.
 { Cancels a selected item.

Returns to the previous settings. Not available when entering an IP address.

12 <READY> indicator Lights up green in on line mode and turns off in off line mode.

13 <ATTENTION> indicator Lights up or blinks orange when an error occurs in the device.

How to Use the Ten-Key Pad

Use to enter numbers and characters.

Each time a numeric key is pressed, entered 
numbers or characters are changed cyclically in 
the following order:

<1>: 1

<2>: a → b → c → 2 → a

<3>: d → e → f → 3 → d

<4>: g → h → i → 4 → g

<5>: j → k → l → 5 → j

<6>: m → n → o → 6 → m

<7>: p → q → r → s → 7 → p

<8>: t → u → v → 8 → t

<9>: w → x → y → z → 9 → w

<0>: 0

The functions of < > and <C> keys are the 
followings:

< >: Function key (Available only when the 
standby screen is displayed.)

<C>: Deletes a character when entering a 
password.

To enter “abc” for example, 
press <2> → <ENTER> button → <2> → <2> 
→ <ENTER> button → <2> → <2> → <2> → 
<ENTER> button.
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How to Use the Function Key

Press numeric keys after pressing the <Fn> 
key when the message “Ready To Print” 
appears on the display screen. The function 
menu corresponding to the number entered is 
displayed.

1 Press the <Fn> key.

2 Press the numeric keys (0-9) to display 
the desired function item and press the 
<ENTER> button.

3 The setting screen of the selected 
function is displayed. Check or change 
the settings.

Reference

 { For the menu that Function No. is not assigned, refer to 
“Menu List of the Operator Panel” P.134.

Function Menu List

Function No. Function menu

1 Encrypted Job

2 Stored Job

10 Paper Size (Tray 1)

11 X Dimension (Tray 1)

12 Y Dimension (Tray 1)

13 Media Type (Tray 1)

14 Media Weight (Tray 1)

15 Legal Paper (Tray 1)

16 Other Size (Tray 1)

20 Paper Size (Tray 2)

21 X Dimension (Tray 2)

22 Y Dimension (Tray 2)

Function No. Function menu

23 Media Type (Tray 2)

24 Media Weight (Tray 2)

25 Legal Paper (Tray 2)

26 Other Size (Tray 2)

30 Paper Size (Tray 3)

31 X Dimension (Tray 3)

32 Y Dimension (Tray 3)

33 Media Type (Tray 3)

34 Media Weight (Tray 3)

35 Legal Paper (Tray 3)

36 Other Size (Tray 3)

40 Paper Size (Tray 4)

41 X Dimension (Tray 4)

42 Y Dimension (Tray 4)

43 Media Type (Tray 4)

44 Media Weight (Tray 4)

45 Legal Paper (Tray 4)

46 Other Size (Tray 4)

80 Paper Feed

90 Paper Size (MP Tray)

91 X Dimension (MP Tray)

92 Y Dimension (MP Tray)

93 Media Type (MP Tray)

94 Media Weight (MP Tray)

95 Tray Usage (MP Tray)

100 Coniguration
101 Network

102 Usage Report

103 Error Log

200 Power Save Time

201 Sleep Time

202 Auto Power Off Time

210 Error Report

220 X Adjust

221 Y Adjust

222 Duplex X Adjust

223 Duplex Y Adjust

230 Paper Black Setting

231 Paper Color Setting

232 Trans. Black Setting

233 Trans. Color Setting

234 SMR Setting

235 BG Setting

236 Drum Cleaning

237 Hex Dump

300 Adjust Density

301 Adjust Registration

302 Print Tuning Pattern

310 Cyan Darkness

311 Magenta Darkness

312 Yellow Darkness

313 Black Darkness
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Names of Components

1

2

3

4

5

6

7

8

8

No. Name

1 Front cover

2 Front cover open lever

3 Operator panel

4 Power switch

5 Top cover

6 Multipurpose tray

7 Tray 1

8 Air vents

9

10

11

12

13

14

15

No. Name

9 Top cover open button

10 Toner cartridge  
Image drum (K: black)

11 Toner cartridge  
Image drum (Y: yellow)

12 Toner cartridge  
Image drum (M: magenta)

13 Toner cartridge  
Image drum (C: cyan)

14 Fuser unit

15 LED head (four heads)

16

17

No. Name

16 Multipurpose tray

17 Paper set cover

18

22

19

20

21

No. Name

18 Faceup stacker

19 AC power socket

20 Interface part

21 Access cover

22 Duplex unit (Only for the model of the name 
with dn or ES)

 { Interface part

23

24

25

No. Name

23 Accessory connector

24 USB interface connection

25 Network interface connection
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Available Options

The following options are available for your 
printer:

 { Additional tray unit (tray 2/3/4)

 { Additional RAM (256 MB or 512 MB)

 { 16 GB SD memory card kit

Reference

 { For details on how to install the options, refer to 
“Installing Options” P.23.

 { An SD memory card kit is used for functions such as a 
storage for spooling when copying sectors, saving secure 
print/encrypted print data, and as a storage destination 
for form data. For information on secure print, encrypted 
secure print and form data storage functions, please refer 
to the User’s Manual (Advanced).
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●{ Checking the Placement Environment

Placement Environment

Your printer must be placed in the following 
environment:

Temperature: 10 - 32°C

Humidity:
20% - 80% RH 
(relative humidity)

Maximum 
wet bulb 
temperature:

25°C

Recommended 
environment:

17 - 27°C, 50 - 70 % RH

Note

 { Be careful of condensation. It may cause a malfunction.

 { If placing your printer in a location where the humidity of the surrounding air is less than 30% RH, use a humidiier 
or antistatic mat.

WARNING

 { Do not install near high temperature or the ire.
 { Please do not install in a place from which a 
chemical reaction is started (laboratory etc.).

 { Do not install near the inlammable solution, such 
as alcohol and thinner.

 { Do not install in the place which the small child's 
hand reaches.

 { Do not install in an unstable place (the shaky 
stand, leaning place, etc.).

 { Do not install in a place many humidity, dusty and 
the place where direct rays hit.

 { Do not install in the environment of briny air and 
corrosive gas.

 { Do not install in a place with much vibration.
 { Do not install in a place where the ventilation hole 
of the printer is closed.

CAUTION

 { Do not place directly on a rug or carpet with long 
strands.

 { Do not install in a closed room with poor 
ventilation and circulation.

 { If you use the printer in a small room for a long 
time, please make sure that you ventilate the 
room.

 { Install away from strong magnetic ields and 
sources of noise.

 { Install away from monitors or TVs.

Placement Space

Place your printer on a lat surface that is wide 
enough that the printer’s feet securely on the 
surface.

Allow for enough room around your printer as 
shown in the images below.

 { Top view

20 cm

20 cm

100 cm60 cm

 { Side view

70 cm
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●{ Preparing Your Printer

This section explains how to unpack your printer and how to turn it on and off.

Unpacking

CAUTION It may cause injury!

 { At least two people are needed to lift the printer 
safely because it weighs about 37 Kg or 40 Kg.

Note

 { Be sure to use the consumables or maintenance units provided with this printer at irst. Otherwise, the life of the 
consumables or maintenance units may not be displayed 
correctly, or you may not be able to use them later.

 { The image drum (the green tube) is very delicate. Handle 
it carefully.

 { Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

 { Packaging and cushioning material are needed if 
transporting the printer. Do not throw them away.

1 Remove your printer from the box and 
remove all cushioning materials and the 
plastic bag from your printer.

2 Remove the two strips of protective tape 
(1) at the back of your printer.

1

Installing Consumables

1 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

Note

 { Open the front cover gently. If opening rapidly, an MP 
tray may open.

1

2

2 Press the top cover open button (3) and 
open the top cover (4).

3

4

3 Take out all four image drums from the 
printer.
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4 Remove the protective sheets from four 
image drums.

(1) Place an image drum on a 
newspaper. Remove a tape (6) stuck 
on a protective sheet (5) and open it.

6

5

(2) Pull out a protective sheet to the 
direction of the arrow.

➊

➋

Note

 { Do not turn the blue lever of the toner cartridge.

5 Put all four image drums back into a 
printer.

6 Turn the blue lever (7) of the toner 
cartridge in direction of the arrow fully.

Turn the levers of all four 4 toner cartridges.

7

7 Close the top cover (4) by pushing the both sides of the cover irmly.
4

8 Close the front cover (2).

Note

 { The front cover cannot be closed securely if the top cover 
is not closed.

 { When the error message that the top or front cover is 
open does not disappear from the operator panel’s display 
screen, make sure they are closed securely.

2
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Installing Accessories

If you want to adjust a direction of air emitted 
from a printer, install a louver.

1 Install the supplied louver (1) on the air 
vent on the side of the printer.

1

Memo

 { Turn a louver to change a direction of air emitted from a 
printer.

Loading Paper

Reference

 { Please refer to “Supported Paper” P.59 for information 
on how to load paper into the printer.

1 Pull out the paper tray (1).

1

2 Set the paper size dial (2) to match the 
loading paper size. 

Set the dial to [A4 ] when loading the A4 size 
paper with a landscape orientation.

A4

A4

A5

A5

2
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3 Slide the paper guide (3) and paper 
stopper (4) to the size of paper to be 
loaded.

3

4

Note

 { When loading the A6 size paper, move the paper 
stopper (4) forward and remove it once, then install 
it on the metal part.

4

4 Flex paper back and forth, and then fan 
it. Straighten the edges of the paper 
stack on a level surface.

5 Load paper with the print side face down 
and press it from above.

Note

 { Do not load paper exceeding the [▼] mark (5) of the 
paper guide.

5

6 Secure the loaded paper with the paper 
guide.

7 Check if a size of loaded paper matches 
the setting of paper size dial.

8 Return the paper tray to the printer.

Memo

 { If loading a paper that you cannot select the 
size with a paper size dial options, set the dial to 
[Other], and then set a paper size on the operator 
panel.
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Turning On/Off the Power

Power Supply Conditions

The power supply must meet the following 
conditions:

Current: 110 - 127 VAC (Range 99 - 140 VAC)

220 - 240 VAC (Range 198 - 264 VAC)

Frequency: 50/60 Hz ± 2%

Note

 { If the power supply is unstable, use a voltage regulator.

 { The maximum power consumption of this printer is  1400 W. Ensure that the power supply is suficient to 
operate this printer.

 { We do not guarantee operation where an uninterruptible 
power system (UPS) or inverter is used. Do not use an 
uninterruptible power system (UPS) or inverter.

WARNING

There is a risk of getting 
an electric shock and/or causing ire.

 { Be sure to turn off the power supply switch when 
attaching or removing the AC cable and earth wire.

 { Be sure to connect an earth wire to the grounding 
terminal of exclusive use.

 { Please do not connect with the ground of a water pipe, 
a gas pipe, and a telephone wire, and a lightning rod by 
any means.

 { Make sure to connect with the ground terminal before 
connecting the power cord to the power supply plug.

 { Be sure to plug in and unplug the AC cable while holding 
on to the power supply plug.

 { Insert the AC cable plug completely into the wall socket 
securely.

 { Do not touch the power cord, or printer, if your hands 
are wet.

 { Install a power cord in the place which is not stepped 
on, and do not place a thing on a power cord.

 { Do not use the cord tied in a bundle.
 { Please do not use the damaged power cord.
 { Do not use multi-outlet adapters.
 { Do not connect this printer and other electric products 
to the same wall socket. If it connects simultaneously 
with an air conditioner, copier, shredder, etc. Especially, 
a printer may incorrect-operate by the electric 
noise. When you connect with the same wall socket unavoidably, please use a commercial noise ilter or a 
commercial noise cut transformer.

 { Use the attached power cord and insert it directory with 
the ground terminal. Do not use the power cord for 
other product for the printer.

 { Do not use an extension cord. When you use it 
unavoidably, use the thing more than rated 15 A.

 { Use of an extended code may not operate a printer 
normally by AC voltage descent.

 { During printing, do not shut off a power supply or do not 
pull out a power supply plug.

 { When you use it neither for consecutive holidays nor a 
travel for a long time, pull out a power cord.

 { Do not use attached power cord to the other products.

Turning On the Power

1 Plug the AC cord (1) into the AC power 
socket of your printer.

1

2 Plug the AC cord into the electric socket.

3 Hold down the power switch (2) for 
about 1 second to turn on the power.

2

The Power switch LED indicator lights up when 
the printer turns on.

The message “Ready To Print” is displayed in 
the operator panel once printer is ready.
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Turning Off the Power

1 Hold down the power switch (1) for 
about a second.

The message “Shutting down Please wait. 
Printer will turn off automatically” appears 
in the operator panel, and the power switch 
indicator blinks every 1 second. Then the printer 
turns off automatically and the power switch 
indicator goes out.

Note

 { It may take about 5 minutes to turn off the power. Wait 
until it turns off.

 { Holding down the power switch for more than 5 seconds 
turns off printer forcibly. Only perform this procedure 
when a problem occurs. For printer problems, refer to 
“Other Issues” P.102.

1

 � When the Printer is Not Used for a 
Long Time

When the printer is not used for a long time due 
to consecutive holidays or when on vacation, or 
when changing or attaching parts in repair or 
maintenance, unplug the AC cord. 

Memo

 { The printer will not be functionally impaired even if left 
unplugged for a long time (more than 4 weeks).

Power Save Mode and Sleep Mode

Two-phase power conservation enables you to 
save on power consumed by the printer.

 � Power Save Mode
When your printer is not used for a certain 
period of time, it automatically enters the power 
save mode to reduce the power consumption.

You can enter the power save mode manually 
by pressing the <POWER SAVE> button on the 
operator panel.

The <POWER SAVE> button lights up green 
while in this mode.

Memo

 { By factory default, the time interval before entering the 
power save mode is set to 1 minute. For how to change 
the time that elapses before the printer enters the power 
save mode, refer to “Setting the Time that Elapses Before 
Entering the Power Save Mode” P.76.

 � Sleep Mode
Your printer goes from the power save mode to 
the sleep mode after a set period of time.

In the sleep mode, the status of your printer is 
almost the same as when it is turned off. 

The <POWER SAVE> button blinks while in the 
sleep mode.

Note

 { The printer does not enter the sleep mode if an error 
occurs.

Memo

 { By factory default, the time interval before entering the 
sleep mode is set to 15 minutes. For how to change the 
time that elapses before the printer enters the sleep 
mode, refer to “Setting the Time that Elapses Before 
Entering the Sleep Mode” P.77.

Reference

 { For more detailed information on sleep mode, please refer 
to the User’s Manual (Advanced).

 � Restoring a Printer from the 
Power Saving Mode

To restore the printer from the power save mode 
or the sleep mode, press the <POWER SAVE> 
button on the operator panel.

Memo

 { When the printer receives a print job from a computer or 
other devices, it is restored automatically.
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Auto Power Off Function

When a certain period of time elapses after 
printing, this printer will turn off automatically.

Memo

 { The factory default setting for time that elapses before the 
printer power turns off automatically is 4 hours.

 { For how to change the time that elapses before the 
printer power turns off automatically, refer to “Settings for 
Turning Power Off Automatically (Auto Power Off)” P.80.

Note

 { In the factory default setting, the auto power off mode 
is disabled during network connection. To enable the 
auto power off mode during network connection, refer to 
“Settings for Turning Power Off Automatically (Auto Power 
Off)” P.80.

Installing Options

This section explains how to install options on 
your printer. The following options are available:

 { Additional tray unit (Tray 2/3/4)

 { Additional RAM (256 MB or 512 MB)

 { 16 GB SD memory card kit

Note

 { Be sure to turn off your printer and unplug the AC cord 
and Ethernet or USB cable before installing options. 
Installing options while your printer is turned on may 
damage your printer and options.

Memo

 { After installing options, set the option settings with a 
printer driver. Refer to “When Adding Options” P.56.

Installing an Additional Tray Unit

Install an optional additional tray unit when 
you want to increase the paper capacity of your 
printer. You can install up to three additional tray units. After installation, you need to conigure 
the printer driver settings.

N35110A

Reference

 { For speciications of the additional tray unit, refer to 
“Supported Paper” P.59.

CAUTION It may cause injury!

 { At least two people are needed to lift the printer 
safely because it weighs about 37 Kg or 40 Kg.

1 Turn off your printer, and then unplug 
the AC cord and the Ethernet or USB 
cable.

Reference

 { “Turning Off the Power” P.22
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2 Stack an additional tray aligning a back 
side of each tray.

3 Place a printer on the additional trays 
gently aligning the back sides of a 
printer and the additional trays.

4 Plug the AC cord and Ethernet or USB 
cable into your printer, and then turn on 
the power switch.

 { Do not apply force to the printer’s top cover 
while it is open.

 { Do not apply downward force to the paper tray 
while it is pulled out.

 { Do not apply force to the printer from the back 
while the paper tray is pulled out.
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Installing Additional RAM

Install additional RAM to increase the memory 
capacity of your printer in cases such as if memory overlow or the collate print errors 
occur. Your printer supports 256 MB and 512 MB 
RAM.

Note

 { Use only genuine Oki Data products. The performance 
cannot be guaranteed when using other products.

 { The static electricity may damage parts. Discharge the 
static electricity from your body by touching grounded 
metallic parts, etc., before work.

Memo

 { For banner printing, installing additional memory is 
recommended.

1 Turn off your printer, and then unplug 
the AC cord and Ethernet or USB cable.

Reference

 { “Turning Off the Power” P.22

2 Open the access cover (1) on the right 
side of a printer.

1

3 Slide the metal plate (2) upward to 
remove.

Note

 { If the SD memory card socket is attached, remove 
the SD memory card.

(1) Put your inger in the recess of the 
metal plate (2), and slide it upward.

2

(2) Pinch the lower part of the metal 
plate (2), and pull it forward.

2

4 Make sure the LED (3) indicated by the 
arrow turns off. If it is lit, wait until it 
turns off.

3
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5 Insert the additional RAM (4) into the slot and ix it by pushing it toward the 
printer. 

Note

 { Be sure to check a direction of an additional RAM. 
The additional RAM has small dents on its connector, which are itted with a connector of a slot.

4

6 Install the metal plate (2).

(1) First, insert the upper part of the 
metal plate (2) in the printer, then 
install the metal plate.

➊

➋

2

(2) While holding the lower part of the 
metal plate (2), slide the metal plate 
downward and secure it.

2

➊

➋

Note

 { Attach the SD memory card socket before installing 
the metal plate if the SD memory card socket was 
attached to the printer.

7 Close the access cover (1).

1

8 Plug the AC cord and Ethernet or USB 
cable into your printer, and then turn on 
the power switch.

9 Press the <ENTER> button on the 
operator panel.

10 Check that [Coniguration] is selected 
and press the <ENTER> button.

11 Press the scroll button  several times 
to select [System] and press the 
<ENTER> button.
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12 Press the scroll button  several times 
to select [Total Memory] and press the 
<ENTER> button. 

13 Check that the value of [Total Memory] 
has increased.

 - For memory expanded to 256 MB, it is 
[512 MB]; for memory expanded to 512 
MB, it is [768 MB].

Note

 { If the value of [Total Memory] has not increased, turn 
off your printer and unplug the AC cord and Ethernet or 
USB cable, and then reinstall the additional RAM.

14 Press the <ON LINE> button.

Installing the 16-GB SD Memory 
Card Kit

For storing print data or a secure printing, install 
the SD memory card kit.

SD memory socket

SD memory card

Memo

 { The SD memory socket is attached to the SD memory 
card. 

Note

 { Use only genuine Oki Data products. The performance 
cannot be guaranteed when using other products.

 { The static electricity may cause damage to the parts. 
Discharge the static electricity in your body by touching 
grounded metallic parts, etc. before work.

 { You can not use the SD memory card with the protection 
switch for accidental overwriting locked. Make sure to 
release the lock.

1 Turn off your printer, and then unplug 
the AC cord and Ethernet or USB cable.

Reference

 { “Turning Off the Power” P.22

2 Open the access cover (1).

1
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3 Remove the metal plate (2) by sliding it 
upward.

(1) Put your inger in the recess of the 
metal plate (2), and slide it upward.

2

(2) Pinch the lower part of the metal 
plate (2), and pull it forward.

2

4 Make sure the LED (3) indicated by the 
arrow turns off. If it is lit, wait until it 
turns off.

3

5 Install the SD memory card (4) into the 
SD memory card socket (5).

4

5

6 Install the SD memory socket to the 
printer with the screw (6) and tab (7) for 
the SD memory card socket and attach 
the connector (8).

6

7

8

7 Install the metal plate (2).

(1) First, insert the upper part of the 
metal plate (2) in the printer, then 
install the metal plate.

➊

➋

2
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(2) While holding the lower part of the 
metal plate (2), slide the metal plate 
downward and secure it.

2

➊

➋

8 Close the access cover (1).

1

9 Plug the AC cord and Ethernet or USB 
cable into your printer, and then turn on 
the power switch.

10 Press the <ENTER> button on the 
operator panel.

11 Check that [Coniguration] is selected 
and press the <ENTER> button.

12 Press the scroll button  several times 
to select [System] and press the 
<ENTER> button.

13 Press the scroll button  several times 
to select [SD Card] and press the 
<ENTER> button.

14 Check that the value of [SD Card] is 
[16 GB].

Note

 { [15 GB] may be displayed in [SD Card]. This is not an 
error.

 { If the value of [SD Card] has not increased, turn off 
your printer and unplug the AC cord and Ethernet or USB 
cable, and then reinstall the SD memory card.

15 Press the <ON LINE> button.
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Test Printing from the Printer

Check that you can print with the printer. Check 
the detailed settings and status of your printer 
by printing the contents of the settings (Menu 
Map).

Note

 { When a printer is in the power saving mode, press the 
<POWER SAVE> button to restore from the mode.

1 Press the <Fn> key on the operator 
panel.

2 Enter “100” using the ten-key pad and 
press the <ENTER> button.

3 Press the <ENTER> button as 
[Execute] is selected.

4 After inishing a print of printer settings, 
a setup for printing from a printer 
completes.

Reference

 { You can also print reports and lists for each function. 
Refer to the User’s Manual (Advanced).
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●{ Connecting to a Computer

This section explains how to connect your printer to a computer and install a printer driver software 
using the provided “Software DVD-ROM”.

Prepare a computer with a DVD drive.

 � Connection Method
You can select either of the following connection methods:

 { “Network Connection” P.32

 { “USB Connection” P.52

 � Product Requirements
Your printer supports the following operating systems:

 { Windows 7/Windows 7 (64bit Version)

 { Windows Vista/Windows Vista (64bit Version)

 { Windows Server 2008 R2

 { Windows Server 2008/Windows Server 2008 (x64 Version)

 { Windows XP/Windows XP (x64 Version)

 { Windows Server 2003/Windows Server 2003 (x64 Version)

 { Windows 2000

 { Mac OS X 10.3.9 to 10.7

 � Types of Drivers
The types of the drivers that can be installed are as follows.

 { For Windows

Type Description

PCL The PCL printer driver is suitable for printing of business documents. For Windows XP/Windows 
2000, Internet Explorer 6.0 or later (MSXML 4.0 or later) must be installed.

PS The PS printer driver is suitable for printing of documents including PostScript fonts and EPS data.

XPS The XPS printer driver is suitable for printing from an application for XPS.

* Windows XP/ Windows Server 2003 and Windows 2000 are not supported.

 { For Mac OS X

Type Description

PS The PS printer driver is suitable for printing of documents including PostScript fonts and EPS data.
It can be also used for normal printing.

Note

 { Depending on the printer driver version or the version of Windows or Mac OS X, the description may be different.
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Network Connection

Perform the following procedure to connect your 
printer to a computer via network.

Connecting an Ethernet Cable

Be sure to connect your printer to a network 
with an Ethernet cable before driver installation.

1 Prepare an Ethernet cable (1) and a hub 
(2).

Prepare an Ethernet cable (category 5, twisted 
pair, straight) and a hub separately.

1

2

2 Turn off your printer and computer.

Reference

 { “Turning Off the Power” P.22

3 Plug one end of the Ethernet cable into 
the network interface connection (3) on 
the back of the printer.

4 Plug the other end of the Ethernet cable 
into the hub (2).

3

2

Installing a Printer Driver  
(for Windows)

To complete the network connection with a Windows computer, irst set IP addresses for the 
printer, and then install a printer driver on the 
computer.

If there is no DHCP server or BOOTP server on the network, you need to manually conigure the 
IP address on the computer or printer.

If your network administrator or internet service provider speciies an unique IP address for the 
computer and your printer, you need to set the 
IP addresses manually.

Note

 { You need to complete the network setting of the computer 
before this procedure.

 { To complete this procedure, you must be logged in as an 
administrator.

 { When setting an IP address manually, ask the network 
administrator or your internet service provider which 
IP address to use. If the IP address is set wrong, the 
network may go down or Internet access may be disabled.

Memo

 { If coniguring a small network consisting of only your 
printer and a computer, set IP addresses as shown below 
(according to RFC1918).

For the computer

IP address : 192.168.0.1 - 254

Subnet mask : 255.255.255.0

Default gateway : not used

DNS server : not used

For the printer

IP address Set : Manual

IP address: 
192.168.0.1 - 254 (select a 
different value from that of the 
computer)

Subnet Mask : 255.255.255.0

Default Gateway : 0.0.0.0

Network Scale : Small

 { To set [Network Scale], press the <ENTER> button 
and then select [Admin Setup] > [Network Setup] > 
[Network Scale].
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 �First, Set the IP address of the printer.

1 Turn on the printer.

2 Press the <ENTER> button on the 
operator panel.

3 Press the scroll button  to select 
[Admin Setup], and press the 
<ENTER> button.

4 Enter the administrator password, using 
the numeric (0-9) keys.

The factory default password is “aaaaaa”. Press 
<ENTER> button after each character you input. 

5 Press the <ENTER> button.

6 Check that [Network Setup] is selected 
and press the <ENTER> button.

7 Press the  to select [IP Address Set], 
and press the <ENTER> button.

8 If setting the IP address manually, press 
the scroll button  and select [Manual], 
and press the <ENTER> button. 
Proceed to the step 9.

If obtaining the IP address automatically, check 
that [Auto] is selected, and press the <ENTER> 
button. 

Proceed to the step 15.

9 Press the <BACK> button until 
[Network Setup] is displayed. 
Press the scroll button  to select 
[IPv4 Address], and press the 
<ENTER> button.
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10 Enter the IP address using the numeric 
(0-9) keys, and press the <ENTER> 
button.

To move to the next box, press the <ENTER> 
button.

C��� �������

11 Press the <BACK> button until 
[Network Setup] is displayed. 
Press the scroll button  to select 
[Subnet Mask], and press the 
<ENTER> button.

12 Enter the subnet mask in the same 
manner of IP address.

To move to the next box, press the <ENTER> 
button.

13 Press the <BACK> button until 
[Network Setup] is displayed. 
Press the scroll button  to select 
[Gateway Address], and press the 
<ENTER> button.

14 Enter the default gateway address and 
press the <ENTER> button.

To move to the next box, press the <ENTER> 
button.

After entering all settings, press the <BACK> 
button.

15 When the setup menu screen is 
displayed, press the <ON LINE> button 
to complete the network settings.
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 �Next, install the printer driver on the 
computer.

1 Ensure that your printer and the 
computer are turned on and connected, 
and then insert the “Software DVD-ROM” 
into the computer.

Reference

 { “Connecting an Ethernet Cable” P.32

2 Click [Run Setup.exe] after 
[Auto Play] is displayed.

If the [User Account Control] dialog box 
appears, click [Yes].

3 Select the language, and then click 
[Next].

4 Select the model of your printer, and 
then click [Next].

5 Read the license agreement and then 
click [I Agree].

6 Read the [Environmental advice for 
Users] and then click [Next].

7 Select a check box for the driver to 
install from [PCL driver], [PS driver] 
or [XPS driver] under [Software].

8 Click the install bunch button on the top.

Memo

 { To batch install software, select check boxes of 
software to be installed. 
To install software separately, click the install 
button on the right side of each item, and follow the 
instructions displayed on a screen.

Icon Description

Click  to install the drivers and/or 
software that have been check-box 
selected.

Click  on the right side of each 
item to install driver or software 
individually.

Install bunch button

Install buttons (separately)

Installation starts.

Memo

 { Color Correct Utility also installed simultaneously 
with printer driver.

9 If the [Windows Security] dialog box 
appears, click [Install this driver 
software anyway].
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10 Click [Network].

The device search starts.

 - If the printer is detected, the software is 
automatically installed. Proceed to step 
12.

 - If the printer is not detected, the 
[Installation settings] screen is 
displayed. Proceed to step 11.

11 Click [Restart search] to restart the 
device search.

After the printer is displayed, select the printer 
and click [Next].

Memo

 { If the printer is not displayed by clicking [Restart 
search], select [IP address] and enter the IP 
address assigned to your printer, and then click 
[Next].

12 If the [Windows Security] dialog box 
appears, click [Install this driver 
software anyway].

13 Click [Exit] to complete the installation.

Note

 { If the dialog box prompting to restart the computer 
appears, click [Yes]. The computer automatically 
restarts.

Reference

 { For how to conigure the tray settings by the driver, 
refer to “When Adding Options” P.56.

14 Click [Start] > [Devices and Printers].

15 Check that the [OKI C831] icon is 
displayed.

Right-click the [OKI C831] icon and select one 
of the menu items, and then check that all the 
printer drivers installed are displayed in the 
submenu.

16 Remove the “Software DVD-ROM” from 
the computer.

 �Finish by test printing from a computer.

1 Open a printer driver property.

2 Click Test Print.

The installation is complete.

 � If installing the options such as an 
additional tray unit or the SD memory 
card kit, specify the settings with a printer 
driver. Refer to “When Adding Options” 
P.56.
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Installing a Printer Driver 
(For Mac OS X)

To complete the network connection with a Mac 
operating system, install a printer driver on the 
computer and set your printer as a network 
printer.

Select the protocol for your network connection 
from the following:

 { EtherTalk

 { Bonjour (Rendezvous for Mac OS X 10.3)

Note

 { EtherTalk is not supported in Mac OS X 10.6.

 { Disable the anti-virus software before starting this 
procedure.

 � Using EtherTalk (For Mac OS X 10.5)
When connecting to the network with EtherTalk, 
it is necessary to enable EtherTalk and disable 
the sleep mode on the printer. After doing that, 
install the driver on the computer.

 �First, enable EtherTalk and disable the 
sleep mode on the printer.

1 Ensure that your printer and the 
computer are turned on and connected.

Reference

 { “Connecting an Ethernet Cable” P.32

2 Press the <ENTER> button on the 
operator panel.

3 Press the scroll button  several times 
to select [Admin Setup], and press the 
<ENTER> button.

4 Enter the administrator password, using 
the numeric (0-9) keys.

The factory default password is “aaaaaa”. Press 
the <ENTER> button after each character you 
input. 

5 Press the <ENTER> button.

6 Check that [Network Setup] is selected 
and press the <ENTER> button.

7 Press the scroll button  several times 
to select [EtherTalk], and press the 
<ENTER> button.

�	
��� �	
�� ���

8 Press the scroll button  to select 
[Enable], and press the <ENTER> 
button.

��������� ���

 !"#$%
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9 Press the <BACK> button until 
[Network Setup] is displayed.

10 Press the <BACK> button until 
[Admin Setup] is displayed.

11 Press the scroll button  several times 
to select [Power Setup], and press the 
<ENTER> button.

12 Press the scroll button  to select 
[Sleep], and press the <ENTER> 
button.

13 Press the scroll button  to select 
[Disable], and press the <ENTER> 
button.

14 Press the <ON LINE> button to exit the 
menu mode.

 �Then, install the printer driver on the 
computer.

1 Insert the “Software DVD-ROM” into the 
computer.

2 Double-click the [OKI] icon on the 
desktop.

3 Double-click [Driver] > 
[C841_C831_ES84x1] > 
[Installer for Mac OSX].

4 Enter the administrator’s password for 
Mac OS X, and then click [OK].

Follow the instructions displayed on the screen to 
complete the installation.

5 From the Apple menu, select [System 
Preferences].

6 Click [Print & Fax].

7 Click [+].
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8 Click [AppleTalk].

9 Select the name of your printer and then 
check that [OKI C831(PS)] is displayed 
in [Print Using].

10 Click [Add].

11 Check that your printer is displayed 
in [Printers] and [OKI C831(PS)] is 
displayed in [Kind].

Note

 { If [OKI C831(PS)] is not correctly displayed in 
[Kind], click [-] to remove your printer from [Print & Fax] and then redo the procedure from steps 7 to 
10.

12 Close [Print & Fax].

13 Remove “Software DVD-ROM” from the 
computer.

 �Next, enable the sleep mode on the 
printer. 
Note

 { If using the EtherTalk, disable the sleep mode.

1 Press the <ENTER> button on the 
operator panel.

2 Press the scroll button  several times 
to select [Admin Setup], and then 
press the <ENTER> button.

3 Enter the administrator password, using 
the numeric (0-9) keys.

The factory default password is “aaaaaa”. Press 
the <ENTER> button after each character you 
input. 

4 Press the <ENTER> button.
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5 Press the scroll button  several times 
to select [Power Setup], and press the 
<ENTER> button.

6 Press the scroll button  to select 
[Sleep], and press the <ENTER> 
button.

7 Press the scroll button  to select 
[Enable], and press the <ENTER> 
button.

8 Press the <ON LINE> button to exit the 
menu mode.

 �Finish by test printing from a computer.

1 Start up [TextEdit].
2 Open an appropriate ile.
3 Start printing.

The installation is complete.

 � If installing the options such as an 
additional tray unit or the SD memory 
card kit, specify the settings with a printer 
driver. Refer to “When Adding Options” 
P.56.
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 � Using EtherTalk (For Mac OS X 10.3.9 to 10.4.11)
When connecting to the network with EtherTalk, 
it is necessary to enable EtherTalk and disable 
the sleep mode on the printer. After doing that, 
install the driver on the computer.

Memo

 { The following procedure uses Mac OS X 10.4.11 as an 
example. Depending on an OS, the description may be 
different.

 �First, enable EtherTalk and disable the 
sleep mode on the printer.

1 Ensure that your printer and the 
computer are turned on and connected.

Reference

 { “Connecting an Ethernet Cable” P.32

2 Press the <ENTER> button on the 
operator panel.

3 Press the scroll button  several times 
to select [Admin Setup], and press the 
<ENTER> button.

4 Enter the administrator password, using 
the numeric (0-9) keys.

The factory default password is “aaaaaa” Press 
the <ENTER> button after each character you 
input. 

5 Press the <ENTER> button.

6 Check that [Network Setup] is selected 
and press the <ENTER> button.

7 Press the scroll button  several times 
to select [EtherTalk], and press the 
<ENTER> button.

8 Press the scroll button  to select 
[Enable], and press the <ENTER> 
button.

&'()*+,-. /0/

123456

9 Press the <BACK> button until 
[Network Setup] is displayed.
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10 Press the <BACK> button until 
[Admin Setup] is displayed.

11 Press the scroll button  several times 
to select [Power Setup], and press the 
<ENTER> button.

12 Press the scroll button  to select 
[Sleep], and press the <ENTER> 
button.

13 Press the scroll button  to select 
[Disable], and press the <ENTER> 
button.

14 Press the <ON LINE> button to exit the 
menu mode.

 �Then, install the printer driver on the 
computer.

1 From the Apple menu, select [System 
Preferences].

2 Select [Network].

3 Select [Network Port Conigurations] 
from [Show], and then check that 
[Built-in Ethernet] is selected.

4 Select [Built-in Ethernet] from [Show] 
and select the [AppleTalk] tab, and 
then check that [Make AppleTalk 
Active] is selected.

5 Close [Network].

6 Insert “Software DVD-ROM” in the 
computer.

7 Double-click the [OKI] icon on the 
desktop.

8 Double-click [Driver] folder > 
[C841_C831_ES84x1] folder > 
[Installer for Mac OSX].
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9 Enter the administrator’s password for 
MacOS X, and then click [OK].

Follow the instructions displayed on the screen to 
complete the installation.

10 From the [Go] menu, select [Utilities] 
and then double-click [Printer Setup 
Utility].

Note

 { If [Printer Setup Utility] is already running, close it 
and open it again.

11 Click [Add].

If the [You have no printers available] dialog 
box appears, click [Add].

12 Select the name of the printer where 
[Connection] is [AppleTalk], and then 
check that [OKI C831(PS)] is displayed 
in [Print Using].

For Mac OS X 10.3.9, set as follows.

a Select [AppleTalk] from the pop-up 
menu.

b Select the printer from the list.

c Select [Oki] from [Printer Model] 
and then select [OKI C831(PS)] 
from the driver list.

13 Click [Add].

14 Check that the name of your printer is 
displayed in [Printer List], and then 
close the window.

15 From the [Go] menu, select 
[Applications] and then double-click 
[TextEdit].

16 Select the [File] menu > [Page Setup].

17 Select the name of your printer from 
[Format for].

18 Check that the [OKI C831(PS)] is 
displayed correctly under [Format for].

19 Click [OK].

20 Remove “Software DVD-ROM” from the 
computer.

 �Next, enable the sleep mode on the 
printer. 
Note

 { If using the EtherTalk, disable the sleep mode.

1 Press the <ENTER> button on the 
operator panel.



- 44 -

Connecting to a Computer

1

1
. 

S
e
tu

p

2 Press the scroll button  several times 
to select [Admin Setup], and then 
press the <ENTER> button.

3 Enter the administrator password, using 
the numeric (0-9) keys.

The factory default password is “aaaaaa”. Press 
the <ENTER> button after each character you 
input. 

4 Press the <ENTER> button.

5 Press the scroll button  several times 
to select [Power Setup], and press the 
<ENTER> button.

6 Press the scroll button  to select 
[Sleep], and press the <ENTER> 
button.

7 Press the scroll button  to select 
[Enable], and press the <ENTER> 
button.

8 Press the <ON LINE> button to exit the 
menu mode.

 �Finish by test printing from a computer.

1 Start up [TextEdit].
2 Open an appropriate ile.
3 Start printing.

The installation is complete.

 � If installing the options such as an 
additional tray unit or the SD memory 
card kit, specify the settings with a printer 
driver. Refer to “When Adding Options” 
P.56.
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 � Using Bonjour (For Mac OS X 10.5 and 10.6)
When connecting to the network with Bonjour, 
it is necessary to disable the sleep mode in the 
printer. After doing that, install the driver on 
the computer and set the printer as a network 
printer.

 �First, disable the sleep mode on the 
printer.

1 Press the <ENTER> button on the 
operator panel.

2 Press the scroll button  several times 
to select [Admin Setup], and press the 
<ENTER> button.

3 Enter the administrator password, using 
the numeric (0-9) keys.

The factory default password is “aaaaaa”. Press 
<ENTER> button after each character you input.

4 Press the <ENTER> button.

5 Press the scroll button  several times 
to select [Power Setup], and press the 
<ENTER> button.

6 Press the scroll button  to select 
[Sleep], and press the <ENTER> 
button.

7 Press the scroll button  to select 
[Disable], and press the <ENTER> 
button.

8 Press the <ON LINE> button to exit the 
menu mode.

 �Then, install the driver on the computer.

1 Ensure that your printer and the 
computer are turned on and connected.

Reference

 { “Connecting an Ethernet Cable” P.32

2 Insert “Software DVD-ROM” into the 
computer.
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3 Double-click the [OKI] icon on the 
desktop.

4 Double-click [Driver] folder > 
[C841_C831_ES84x1] folder > 
[Installer for Mac OSX].

5 Enter the administrator’s password, and 
then click [OK].

Follow the instructions displayed on the screen to 
complete the installation.

6 From the Apple menu, select [System 
Preferences].

7 Click [Print & Fax].

8 Click [+].

9 Click [Default].

10 Select the name of the printer where 
[Kind] is [Bonjour], and then check 
that [OKI C831(PS)] is displayed in 
[Print Using].

The name of your printer is displayed in the 
format of “OKI-C831- (the last six digits of the 
MAC address)”.

11 Click [Add].

12 If the [Installable Options] window is 
displayed, click [Continue].

If you have installed the optional additional 
tray unit before the printer driver installation, conigure each item and then click [Continue].

13 Check that your printer is displayed 
in [Printers] and [OKI C831(PS)] is 
displayed in [Kind].

Note

 { If [OKI C831(PS)] is not correctly displayed in 
[Kind], click [-] to remove your printer from [Print & Fax] and then redo the procedure from step 8 to 
12.

14 Close [Print & Fax].

15 Remove “Software DVD-ROM” from the 
computer.
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 �Next, enable the sleep mode on the 
printer. 
Note

 { If using the Bonjour, disable the sleep mode.

1 Press the <ENTER> button on the 
operator panel.

2 Press the scroll button  several times 
to select [Admin Setup], and then 
press the <ENTER> button.

3 Enter the administrator password, using 
the numeric (0-9) keys.

The factory default password is “aaaaaa”. Press 
<ENTER> button after each character you input. 

4 Press the <ENTER> button.

5 Press the scroll button  several times 
to select [Power Setup], and press the 
<ENTER> button.

6 Press the scroll button  to select 
[Sleep], and press the <ENTER> 
button.

7 Press the scroll button  to select 
[Enable], and press the <ENTER> 
button.

8 Press the <ON LINE> button to exit the 
menu mode.
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 �Finish by test printing from a computer.

1 Start up [TextEdit].
2 Open an appropriate ile.
3 Start printing.

The installation is complete.

 � If installing the options such as an 
additional tray unit or the SD memory 
card kit, specify the settings with a printer 
driver. Refer to “When Adding Options” 
P.56.

 � Using Bonjour (Rendezvous) (for Mac OS X 10.3.9 to 10.4.11)
When connecting to the network with Bonjour, 
it is necessary to disable the sleep mode in the 
printer. After doing that, install the driver on 
the computer and set the printer as a network 
printer.

Memo

 { The following procedure uses Mac OS X 10.4.11 as an 
example. Depending on an OS, the description may be 
different.

 �First, disable the sleep mode on the 
printer.

1 Press the <ENTER> button on the 
operator panel.

2 Press the scroll button  several times 
to select [Admin Setup], and press the 
<ENTER> button.

3 Enter the administrator password.

The factory default password is “aaaaaa”. Press 
<ENTER> button after each character you input.

4 Press the <ENTER> button.
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5 Press the scroll button  several times 
to select [Power Setup], and press the 
<ENTER> button.

6 Press the scroll button  to select 
[Sleep], and press the <ENTER> 
button.

7 Press the scroll button  to select 
[Disable], and press the <ENTER> 
button.

8 Press the <ON LINE> button to exit the 
menu mode.

 �Then, install the printer driver on the 
computer.

1 Ensure that your printer and the 
computer are turned on and connected.

Reference

 { “Connecting an Ethernet Cable” P.32

2 From the Apple menu, select [System 
Preferences].

3 Select [Network].

4 Select [Network Port Conigurations] 
from [Show], and then check that 
[Built-in Ethernet] is selected.

5 Close [Network].

6 Insert “Software DVD-ROM” into the 
computer.

7 Double-click the [OKI] icon on the desktop.

8 Double-click [Driver] folder > 
[C841_C831_ES84x1] folder 
[Installer for Mac OSX].

9 Enter the administrator’s password, and 
then click [OK].

Follow the instructions displayed on the screen to 
complete the installation.

10 From the [Go] menu, select [Utilities] 
and then double-click [Printer Setup 
Utility].

Note

 { If [Printer Setup Utility] is already running, close it 
and open it again.

11 Click [Add].

If the [You have no printers available] dialog 
box appears, click [Add].
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12 Select the name of the printer where 
[Connection] is [Bonjour], and then 
check that [OKI C831(PS)] is displayed 
in [Print Using].

The name of your printer is displayed with the 
format of “OKI-C831- (the last six digits of the 
MAC address)”.

For Mac OS X 10.3.9, set as follows.

a Select [Rendezvous] from the pop-
up menu.

b Select the printer from the list.

c Select [Oki] from [Printer Model] 
and then select [OKI C831(PS)] 
from the driver list.

13 Click [Add].

14 If the [Installable Options] window is 
displayed, click [Continue].

If you have installed the optional additional 
tray unit before the printer driver installation, conigure each item and then click [Continue].

15 Check that the name of your printer is 
displayed in [Printer List], and then 
close the window.

16 From the [Go] menu, select 
[Applications] > [TextEdit].

17 Select the [File] menu > [Page Setup].

18 Select the name of your printer from 
[Format for].

19 Check that [OKI C831(PS)] is displayed 
correctly under [Format for].

20 Click [OK].

21 Remove “Software DVD-ROM” from the 
computer.

 �Next, enable the sleep mode on the 
printer. 
Note

 { If using the Bonjour, disable the sleep mode.

1 Press the <ENTER> button on the 
operator panel.

2 Press the scroll button  several times 
to select [Admin Setup], and then 
press the <ENTER> button.

3 Enter the administrator password, using 
the numeric (0-9) keys.

The factory default password is “aaaaaa”. Press 
<ENTER> button after each character you input. 
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4 Press the <ENTER> button.

5 Press the scroll button  several times 
to select [Power Setup], and press the 
<ENTER> button.

6 Press the scroll button  to select 
[Sleep], and press the <ENTER> 
button.

7 Press the scroll button  to select 
[Enable], and press the <ENTER> 
button.

8 Press the <ON LINE> button to exit the 
menu mode.

 �Finish by test printing from a computer.

1 Start up [TextEdit].
2 Open an appropriate ile.
3 Start printing.

The installation is complete.

 � If installing the options such as an 
additional tray unit or the SD memory 
card kit, specify the settings with a printer 
driver. Refer to “When Adding Options” 
P.56.
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USB Connection

Perform the following procedure to connect your 
printer to a computer via USB.

Connecting a USB Cable

1 Prepare a USB cable (1).

A USB cable is not supplied with your printer. 
Prepare a USB 2.0 cable separately.

1

Memo

 { Use a USB 2.0 Hi-Speed cable for a USB 2.0 Hi-
Speed connection.

2 Turn off your printer and the computer.

Reference

 { “Turning Off the Power” P.22

3 Plug one end of the USB cable into the 
USB interface connector (2) on the back 
of the printer.

4 Plug the other end of the USB cable into 
the computer’s USB interface connector.

2

Note

 { For Windows, do not plug the other end of the USB 
cable into the computer until prompted while a 
printer driver installation.

Note

 { Do not plug the USB cable into the network interface 
connection. Doing so may cause a malfunction.

Installing a Printer Driver  
(For Windows)

Note

 { You must be logged in as an administrator to complete 
this procedure.

1 Ensure that your printer is turned off 
and the USB cable is unplugged from the 
computer.

2 Turn on the computer.

3 Insert “Software DVD-ROM” into the 
computer.

4 Click [Run Setup.exe] after [Auto 
Play] is displayed.

If the [User Account Control] dialog box 
appears, click [Yes]. 

5 Select the language, and then click 
[Next].

6 Select the model of your printer, and 
then click [Next].

7 Read the license agreement and then 
click [I Agree].

8 Read the [Environmental advice for 
Users] and then click [Next].
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9 Select a check box for the driver to 
install from [PCL driver], [PS driver] 
or [XPS driver] under [Software].

10 Click the install bunch button on the top.

Memo

 { To batch install software, select check boxes of 
software to be installed. 
To install software separately, click the install 
button on the right side of each item, and follow the 
instructions displayed on a screen.

Icon Description

Click  to install the drivers and/or 
software that have been check-box 
selected.

Click  on the right side of each 
item to install driver or software 
individually.

Install bunch button

Install buttons (separately)

Installation starts.

Memo

 { Color Correct Utility also installed simultaneously 
with printer driver.

11 If the [Windows Security] dialog box 
appears, click [Install this driver 
software anyway].

12 When connecting the printer to the 
computer, and the instruction prompting 
to turn on the printer appears, plug the 
USB cable into the computer and turn on 
your printer.

Follow the instructions displayed on the screen to 
complete the installation.

Reference

 { “Connecting a USB Cable” P.52

13 Click [Exit] and the installation is 
complete.

14 Click [Start] > [Devices and Printers].

15 Check that the [OKI C831] icon is 
displayed.

Right-click the [OKI C831] icon and select one 
of the menu items, and then check that all the 
printer drivers installed are displayed in the 
submenu.

16 Remove “Software DVD-ROM” from the 
computer.
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 �Finish by test printing from a computer.

1 Open a printer driver property.

2 Click Test Print.

The installation is complete.

 � If installing the options such as an 
additional tray unit or the SD memory 
card kit, specify the settings with a printer 
driver. Refer to “When Adding Options” 
P.56.

Installing a Printer Driver 
(For Mac OS X)

Note

 { Disable the anti-virus software before starting this 
procedure.

 � For Mac OS X 10.5 and 10.6
1 Ensure that your printer and the 

computer are turned on and connected.

Reference

 { “Connecting a USB Cable” P.52

2 Insert “Software DVD-ROM” into the 
computer.

3 Double-click the [OKI] icon on the 
desktop.

4 Double-click [Driver] folder > 
[C841_C831_ES84x1] folder 
[Installer for Mac OSX].

5 Enter the administrator’s password, and 
then click [OK].

Follow the instructions displayed on the screen to 
complete the installation.

6 From the Apple menu, select [System 
Preferences].

7 Click [Print & Fax].

8 Click [+].

Note

 { If the printer is already shown in [Printers], select 
your printer, and click on [-] to delete. After this, 
click [+].

9 Select the name of the printer where 
[Kind] is [USB], and then check 
that [OKI C831(PS)] is displayed in 
[Print Using].

10 Click [Add].

11 Check that the name of your printer 
is displayed in [Printers] and [OKI C831(PS)] is displayed in [Kind].

Note

 { If [OKI C831(PS)] is not correctly displayed, click 
[-] to remove your printer from [Printers] and then 
redo the procedure from steps 8 to 10.
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12 Close [Print & Fax].

13 Remove “Software DVD-ROM” from the 
computer.

 �Finish by test printing from a computer.

1 Start up [TextEdit].
2 Open an appropriate ile.
3 Start printing.

The installation is complete.

 � If installing the options such as an 
additional tray unit or the SD memory 
card kit, specify the settings with a printer 
driver. Refer to “When Adding Options” 
P.56.

 � For Mac OS X 10.3.9 to 10.4.11
Memo

 { The procedure below uses Mac OS X 10.4.11 as an 
example. Depending on your OS, the description may be 
different.

1 Ensure that your printer and the 
computer are turned on and connected.

Reference

 { “Connecting a USB Cable” P.52

2 Insert “Software DVD-ROM”.

3 Double-click the [OKI] icon on the 
desktop.

4 Double-click [Driver] folder > 
[C841_C831_ES84x1] folder > 
[Installer for Mac OSX].

5 Enter the administrator’s password, and 
then click [OK].

Follow the instructions displayed on the screen to 
complete the installation.

6 From the [Go] menu, select [Utilities], 
and then double-click [Printer Setup 
Utility].

Note

 { If [Printer Setup Utility] is already running, close it 
and open it again.

7 Click [Add].

If the [You have no printers available] dialog 
box appears, click [Add].

Note

 { If the name of the printer is already displayed, select 
it and click [Delete], and then click [Add].

8 Select the name of the printer where 
[Connection] is [USB], and then check 
that [OKI C831(PS)] is displayed in 
[Print Using].

For Mac OS X 10.3.9, set as follows.

a Select [USB] from the pop-up menu.

b Select the printer from the list.

c Select [Oki] from [Printer Model] 
and then select [OKI C831(PS)] 
from the driver list.

9 Click [Add].

10 Check that the name of your printer is 
displayed in [Printer List], and then 
close the window.
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11 Remove “Software DVD-ROM” from the 
computer.

 �Finish by test printing from a computer.

1 Start up [TextEdit].
2 Open an appropriate ile.
3 Start printing.

The installation is complete.

When Adding Options

If options such as additional tray unit and/or 
SD memory card kit have been installed, use 
following procedures to change printer driver 
settings.

 � For Windows PCL Driver

1 Click [Start] > [Devices and Printers].

2 Right-click the [OKI C831] icon and 
select [Properties]. (If you have 
installed multiple printer drivers, select 
[Properties] >[OKI C831(PCL)].)

3 Select the [Device Options] tab.

4 If using a network connection, select 
[Get Printer Settings]. 
If using a USB connection, 
enter the total number of trays 
excluding the multipurpose tray in 
[Installed Paper Trays]. For example, 
when three option trays are installed, 
enter “4” as the trays 1, 2, 3 and 4 are 
available.

5 Click [OK].
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 � For Windows PS Driver

1 Click [Start] > [Devices and Printers].

2 Right-click the [OKI C831] icon and 
then select [Properties]. (If you have 
installed multiple printer drivers, select 
[Properties] > [OKI C831(PS)].)

3 Select the [Device Settings] tab.

4 If using a network connection, select 
[Get installed options automatically] 
under [Installable Options], and then 
click [Setup]. 
If using a USB connection, select 
an appropriate number of trays in 
[Available Trays] under [Installable 
Options].

5 Click [OK].

 � For Windows XPS Driver

1 Click [Start] > [Devices and Printers].

2 Right-click the [OKI C831] icon and 
select [Properties]. (If you have 
installed multiple printer drivers, select 
[Properties] > [OKI C831(XPS)].

3 Select the [Device Options] tab.

4 If using a network connection, select 
[Get Printer Settings]. 
If using a USB connection, 
enter the total number of trays 
excluding the multipurpose tray in 
[Installed Paper Trays]. For example, 
when three option trays are installed, 
enter “4” as the trays 1, 2, 3 and 4 are 
available.

5 Click [OK].

 � For Mac OS X PS Driver (Mac OS X 10.5 and 10.6)
1 Select [System Preferences] from the 

Apple menu.

2 Click [Print & Fax].

3 Select the name of your printer and then 
click [Options & Supplies].

4 Select the [Driver] tab.

5 Select the number of available trays in 
[Available Tray], and then click [OK].
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 � For Mac OS X PS Driver (Mac OS X 10.3.9 to 10.4.11)
Memo

 { The following procedure uses Mac OS X 10.4.11 as an 
example. Depending on an OS, the description may be 
different.

1 From [Go], select [Utilities] and then 
double-click [Printer Setup Utility].

2 Select the name of your printer and then 
click [Show Info].

3 Select [Installable Options].

4 Select the number of available trays 
in [Available Tray], and then click 
[Apply Changes].

5 Close [Printer Info].
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2. Printing Basic Operation
This chapter describes how to print documents from a computer.

●{ Supported Paper

Supported Paper Types

For high-quality printing, be sure to use paper types that satisfy requirements such as those for material quality, weight, and surface inish. Please use digital photo print paper.
If not using recommended paper, please check the print quality and the movement of the paper suficiently beforehand to make sure that there are no problems. Your printer supports the following 
types of paper.

Paper Type Paper Size mm (inch) Paper Weight

Plain paper A3 297 x 420 64 to 256 g/m2

For duplex print, 64 to 220 g/m2

Note

 { If the paper size is set at A6, A5, or with 
a paper width narrower than 148 mm (A5 
width), the printing will be slower.

A4 210 x 297

A5 148 x 210

A6 105 x 148

B4 257 x 364

B5 182 x 257

B6 128 x 182

Letter 215.9 x 279.4
(8.5 x 11)

Legal (13 inch) 215.9 x 330.2
(8.5 x 13)

Legal (13.5 inch) 215.9 x 342.9
(8.5 x 13.5)

Legal (14 inch) 215.9 x 355.6
(8.5 x 14)

Executive 184.2 x 266.7
(7.25 x 10.5)

Tabloid (11 x 17)

Statement (5.5 x 8.5)

8K
(260 x 368 mm)

260 x 368

8K
(270 x 390 mm)

270 x 390

8K
(273 x 394 mm)

273 x 394

16K
(184 x 260 mm)

184 x 260

16K
(195 x 270 mm)

195 x 270

16K
(197 x 273 mm)

197 x 273

Custom Width:
64 - 297
Length:
90 - 1321

64 to 256 g/m2
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Paper Type Paper Size mm (inch) Paper Weight

Envelope Com-10 104.8 x 241.3
(4.125 x 9.5)

Envelopes should be 24lb paper, and lap parts of envelopes should be folded
DL 110 x 220

(4.33 x 8.66)

C5 162 x 229
(6.4 x 9)

C4 229 x 324
(9 x 12.76)

Index card Index card 76.2 x 127
(3 x 5)

Label A4 210 x 297 0.1 - 0.2 mm

Letter 215.9 x 279.4
(8.5 x 11)

Partly-printing paper Subject to the plain paper*1 64 to 256 g/m2

Color paper Subject to the plain paper*2 64 to 256 g/m2

Use paper that meets the following conditions*1:

 { Paper that meets the conditions for plain paper.

 { An ink used for a part printing is heat resistant (230°C).

Note

 { When specifying a printing area, please take into account the differences of printing position as followings: 
Print start position: ±2 mm, Paper skew: ±1 mm/100 mm, Image stretch: ±1 mm/100 mm  
(when paper ream weight is 70 kg)

 { This printer cannot print on an ink.

Use paper that meets the following conditions*2:

 { A pigment or an ink used to color paper is heat resistant (230°C). 

 { Paper that has same characteristics with light paper and used for an electronic photo printer.

Paper Recommendations

Your printer will handle a variety of print media, 
including a range of paper weights and sizes.

This section provides general advice on choice of 
media, and explains how to use each type.

The best performance will be obtained when 

using standard 75 - 90 g/m2 paper designed for 
use in copiers and laser printers.

Use of heavily embossed or very rough textured 
paper is not recommended.

Pre-printed stationery can be used, but the ink 
must not offset when exposed to the high fuser 
temperatures used in the printing process.

CAUTION

 { Envelopes should be free from twist, curl or 
other deformations. They should also be of the rectangular lap type, with glue that remains 
intact when subjected to hot roll pressure fusing 
used in this type of printer. Window envelopes are 
not suitable.

 { Labels should also be of the type recommended 
for use in copiers and laser printers, in which the 
base carrier page is entirely covered by labels. 
Other types of label stock may damage the printer 
due to the labels peeling off during the printing 
process.
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Storing Paper

Store paper under the following conditions to 
maintain quality.

 { Inside a cabinet or other dry and dark place

 { On a lat surface
 { Temperature: 20°C

 { Humidity: 50% RH (relative humidity)

Do not store in the following locations.

 { Directly on the loor
 { In direct sunlight

 { Near the inside of an exterior wall

 { On an uneven surface

 { Where static electricity may be generated

 { In places that are excessively hot or where 
temperature rapidly changes

 { Near a copier, air conditioner, heater, or duct

Note

 { Do not unwrap the paper until you are ready to use the 
paper.

 { Do not leave paper unwrapped for a long  period. Doing 
so may result in paper handling and print quality issues.

 { Depending on a media you use, usage conditions and a 
storing conditions, a decrease in paper quality or curling 
of the paper may occur.
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Paper Loaded on the Tray

Your printer has two built-in trays (tray 1 and the MP tray) and an additional tray unit (tray 2/3/4).
Refer to the list below to check the supported paper and capacities of each tray.

Note

 { Duplex printing can not be performed on paper indicated with an asterisk (*).

Tray Supported paper size Paper capacity Paper weight

Tray1  { A3
 { A4
 { A5
 { B4
 { B5
 { A6*
 { Letter
 { Legal 13
 { Legal 13.5
 { Legal 14
 { Executive
 { Tabloid
 { 8K (260 x 368 mm)
 { 8K (270 x 390 mm)
 { 8K (273 x 394 mm)
 { 16K (184 x 260 mm)
 { 16K (195 x 270 mm)
 { 16K (197 x 273 mm)
 { Custom

300 sheets 

(when paper weight is 80 g/m2)

 { Light 

(64 to 82 g/m2)

 { Medium Light 

(83 to 90 g/m2)

 { Medium 

(91 to 105 g/m2)

 { Heavy 

(106 to 128 g/m2)

 { Ultra Heavy1 

(129 to 188 g/m2)

 { Ultra Heavy2 

(189 to 220 g/m2)

Tray2/3/4 
(option)

 { A3
 { A4
 { A5
 { B4
 { B5
 { Letter
 { Legal 13
 { Legal 13.5
 { Legal 14
 { Executive
 { Tabloid
 { 8K (260 x 368 mm)
 { 8K (270 x 390 mm)
 { 8K (273 x 394 mm)
 { 16K (184 x 260 mm)
 { 16K (195 x 270 mm)
 { 16K (197 x 273 mm)
 { Custom

530 sheets 

(when paper weight is 80 g/m2)

 { Light 

(64 to 82 g/m2)

 { Medium Light 

(83 to 90 g/m2)

 { Medium 

(91 to 105 g/m2)

 { Heavy 

(106 to 128 g/m2)

 { Ultra Heavy1 

(129 to 188 g/m2)

Note

 { Weight of paper loaded on an 

additional tray unit is 64 to 

176 g/m2.

 { The speciied paper weight 
of Ultra Heavy1 is described 

as 129 to 188 g/m2, but the 

printable weight is up to 

176 g/m2.
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Tray Supported paper size Paper capacity Paper weight

MP Tray  { A3
 { A4
 { A5
 { B4
 { B5
 { B6
 { A6*
 { Letter
 { Legal 13
 { Legal 13.5
 { Legal 14
 { Executive
 { Tabloid
 { Statement
 { 8K (260 x 368 mm)
 { 8K (270 x 390 mm)
 { 8K (273 x 394 mm)
 { 16K (184 x 260 mm)
 { 16K (195 x 270 mm)
 { 16K (197 x 273 mm)
 { Custom
 { Com-10 Envelope*
 { DL Envelope*
 { C4 Envelope*
 { C5 Envelope*
 { Index Card*

 { 100 sheets 

(when paper weight is 80 g/m2)

 { 10 envelopes

 { Light 

(64 to 82 g/m2)

 { Medium Light 

(83 to 90 g/m2)

 { Medium 

(91 to 105 g/m2)

 { Heavy 

(106 to 128 g/m2)

 { Ultra Heavy1 

(129 to 188 g/m2)

 { Ultra Heavy2 

(189 to 220 g/m2)

 { Ultra Heavy3 

(221 to 256 g/m2)
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●{ How to Print from the Tray

The following procedure explains how to load paper in tray 1 or tray 2/3/4 (option).

Memo

 { This procedure explains to load paper in tray 1. The same procedure is applied to tray 2/3/4.

1 Pull out the paper tray (1).

1

2 Set the paper size dial (2) to match the 
size of the paper to be loaded.

Set the dial to [A4 ] when loading A4 size 
paper in horizontal orientation.

A4

A4

A5

A5

2

3 Slide the paper guide (3) and paper 
stopper (4) to the size of paper to be 
loaded.

3

4

Note

 { When loading A6 size paper, move the paper stopper 
(4) forward and remove it once, then install it on the 
metal part.

4

4 Flex paper back and forth, and then fan 
it. Straighten the edges of the paper 
stack on a level surface.

5 Load paper with the print side face down 
and press it from above.

Note

 { Do not load paper exceeding the [▼] mark (5) of the 
paper guide.

5

6 Secure the loaded paper with the paper 
guide.

7 Check if a size of loaded paper matches 
the setting of paper size dial.

8 Return the paper tray to the printer.

Memo

 { If loading a paper that you cannot select the 
size with a paper size dial options, set the dial to 
[Other], and then set a paper size on the operator 
panel.

9 Open a ile you want to print, and print it.
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●{ How to Print from the MP Tray

This procedure explains how to load paper in the MP tray.

Note

 { Do not load paper of different sizes, types or weights at the same time.

 { When adding paper, remove the paper on the MP tray and straighten the edges of both stacks of paper, and then load them 
again.

 { Do not put anything other than paper for printing in the MP tray. 

1 Open the MP tray (1) forward by inserting your ingers into the front 
recesses (2).

2

2

1

2 Pull out the paper support (3) by holding 
the center part of it.

3

3 Unfold the sub support (4).

4

4 Open the paper set cover (5).

5

5 Adjust the manual feeding paper guide 
(6) to the width of paper to be loaded.

6

6 Insert the paper with the print side face 
up.

Note

 { Do not load paper exceeding the [▼] mark (7) of the 
paper guide.

7
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ABC

When loading paper vertically or horizontally

Com-10, DL, C5

A
B
C

C4

Memo

 { When loading envelopes in the MP tray, load them face up 
with the orientation noted below.

 - Com-10, DL and C5 are loaded with the lap folded and the lap should come to the top side in the feeding 
direction.

 - C4 is loaded with the lap folded and the lap should 
come to the right side in the feeding direction.

Note

 { The paper may be wrinkled or curled after printing.

 { Use paper stored in proper temperature and humidity 
conditions. Do not use paper that is curled or waved 
because of humidity.

 { Do not print on the back side of paper on which other 
printer has printed.

 { Curling of a postcard or an envelope may cause the ink 
absorbing problem. Use paper that is not curled. Correct a 
paper Curling within 2 mm.

 { Printing an envelope with an adhesive lap bent cause the 
ink absorbing problem.

7 Close the paper set cover (5).

5

If always printing on same size or type paper 
from the MP tray, register the paper on the 
operator panel. If printing once, proceed to the 
step 18. 

Note

 { When a printer is in the power saving mode, press 
the <POWER SAVE> button to restore from the 
mode.

 { Make sure that the message “Ready To Print” is 
displayed in the operator panel. If the message is not 
displayed, press the <ON LINE> button.

8 Press the <Fn> key.

9 Enter “90” and press the <ENTER> 
button.

10 When [Paper Size] is displayed, select 
the size of the loaded paper and then 
press the <ENTER> button.

Reference

 { If [Custom] is selected for [Paper Size], you need 
to register the custom size. For how to register the 

custom size, refer to “Printing in Custom Sizes” 
P.69.
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11 Press the <BACK> button until 
[MPTray Conig] is displayed.

12 Press the scroll button  to select 
[Media Type] and then press the 
<ENTER> button.

789:;<

13 Press the scroll button  to select the 
type of the loaded paper and then press 
the <ENTER> button.

14 Press the <BACK> button until 
[MPTray Conig] is displayed.

15 Press the scroll button  to select 
[Media Weight] and then press the 
<ENTER> button.

16 Press the scroll button  to select the 
weight of the loaded paper and then 
press the <ENTER> button.

17 Press the <ON LINE> button to exit the 
menu mode.

18 Open the ile you want to print, and print 
it by following the procedures below.

For Windows PCL Printer Driver

1 From the [File] menu, select [Print].

2 Click [Preferences] or [Properties].

3 On the [Setup] tab, select a paper size 
from [Size].

4 Select [Multipurpose Tray] from 
[Source].

5 Start printing.
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For Windows PS Printer Driver

1 From the [File] menu, select [Print].

2 Click [Preferences] or [Properties].

3 Select the [Paper/Quality] tab.

4 Select [Multi-Purpose Tray] from 
[Paper Source].

5 Click [Advanced].

6 Click [Paper Size] and select a paper 
size from the drop-down list.

7 Click [OK].

8 Start printing.

For Windows XPS Printer Driver

1 From the [File] menu, select [Print].

2 Click [Preferences] or [Properties].

3 On the [Setup] tab, select a paper size 
from [Size].

4 Select [Multipurpose Tray] from 
[Source].

5 Start printing.

For Mac OS X PS Printer Driver

1 From the [File] menu, select [Page 
Setup].

2 Select a paper size from [Paper Size] 
and then click [OK].

3 From the [File] menu, select [Print].

4 Select [Paper Feed] from the panel 
menu.

5 Select [All pages From] and then select 
[Multi Purpose Tray].

6 Start printing.
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●{ Printing in Custom Sizes

To load custom size paper, you need to register the width and length of the paper before printing. The 
range of the sizes you can set differs according to the paper tray.

Tray Available size range

Tray1 Width:
105 to 297 mm (4.1 to 11.7 inches)
Length:
148, 182 to 431.8 mm  
(5.8, 7.2 to 17.0 inches)

Tray 2/3/4 
(Option)

Width:
148 to 297 mm (5.8 to 11.7 inches)
Length:
182 to 431.8 mm (7.2 to 17.0 inches)

MP tray Width:
64 to 297 mm (2.5 to 11.7 inches)
Length:
90 to 1321 mm (3.5 to 52 inches)

Note

 { [Custom] is displayed only when [Paper Size] is set to 
[Custom].

 { The available size range for duplex printing is the same as 
that for tray 2/3/4.

1 Press the <ENTER> button on the 
operator panel.

2 Press the scroll button  several times 
to select [Menus] and press the 
<ENTER> button.

3 Check that [Tray Coniguration] 
is selected and press the <ENTER> 
button.

= >?>

@ABDEF GHIJBD

KLMN OPQRSTULMVSPQ

4 Press the scroll button  several times 
to select [Tray Conig] of the paper 
tray in which you loaded paper and then 
press the <ENTER> button.

WXYZ[\]^_`[XY

abcde fghijk
lmnopq rstuvw

abcdx fghijk
abcd fghijk

5 Check that [Paper Size] is selected and 
press the <ENTER> button.

6 Press the scroll button  several times 
to select [Custom] and then press the 
<ENTER> button.

yz{|} ~��|

7 Press the <BACK> button.
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8 Press the scroll button  to select 
[X Dimension] and then press the 
<ENTER> button.

9 Enter the paper width value using 
the ten-key pad and then press the 
<ENTER> button.

10 Press the <BACK> button.

11 Press the scroll button  to select 
[Y Dimension] and then press the 
<ENTER> button.

12 Enter the paper length value using 
the ten-key pad and then press the 
<ENTER> button.

����������

13 Press the <ON LINE> button to exit the 
menu mode.

14 Specify a custom in the following 
procedures.

For Windows PCL Printer Driver

1 Click [Start] and select [Devices and 
Printers].

2 Right-click the Your Printer icon and 
select the type of driver you want to 
specify from [Printing preferences].

3 On the [Setup] tab, click [Paper Feed 
Options].

4 Click [Custom Size].

5 Enter a name and the dimensions.

a Enter a name for the new size in the 
[Name] box.

b  Enter its dimensions in the [Width] 
and [Length] boxes.

6 Click [Add] to save the custom paper 
size to the list and then click [OK].

 You can save up to 32 custom sizes.

7 Press [OK] until the [Printing 
preferences] dialog box is closed.

8 Open the ile you want to print.
9 Select the registered paper size and 

start printing on the print dialog.
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For Windows PS Printer Driver

1 Click [Start] and select [Devices and 
Printers].

2 Right-click the Your Printer icon and 
select the type of driver you want to 
specify from [Printing preferences].

3 On the [Layout] tab, click [Advanced].

4 Click [Paper Size] and select 
[PostScript Custom Page Size] from 
the drop-down list.

5 Enter the dimensions in the [Width] and 
[Height] boxes, and press [OK].

 

Note

 { [Offsets Relative to Paper Feed Direction] is not 
available.

6 Press [OK] until the [Printing 
preferences] dialog box is closed.

7 Open the ile you want to print from the 
application.

8 Select [PostScript Custom Page Size] 
for a paper size and start printing on the 
printer driver.

For Mac OS X PS Printer Driver

Note

 { In the Mac OS X PS printer driver, paper size out of the 
available range can be set, however, image is not correctly 
printed. set paper size within available range.

1 Open the ile you want to print.
2 From the [File] menu, select [Page 

Setup].

3 Select [Manage Custom Sizes] from 
[Paper Size]

4 Click [+] to add an item to the list of 
custom paper sizes.

5 Double-click [Untitled] and enter a 
name for the custom paper size.

6 Enter the dimensions in the [Width] and 
[Height] boxes.

7 Click [OK].

8 Click [OK].

9 From the [File] menu, select [Print].

10 Conigure other settings if necessary and 
then start printing.

Memo

 { If the print dialog contains only two menus and does 
not contain the options you expect to see on the Mac 
OS X 10.5 or 10.6, click the  button on the side of the 
[Printer] menu.
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 �Open the ile you want to print, and print 
it in the following procedures.

For Windows PCL Printer Driver

1 From the [File] menu, select [Print].

2 Click [Preferences] or [Properties].

3 On the [Setup] tab, select a paper size 
from [Size].

4 Select [Multipurpose Tray] from 
[Source].

5 Start printing.

For Windows PS Printer Driver

1 From the [File] menu, select [Print].

2 Click [Preferences] or [Properties].

3 Select the [Paper/Quality] tab.

4 Select [Multipurpose Tray] from 
[Paper Source].

5 Click [Advanced].

6 Click [Paper Size] and select a paper 
size from the drop-down list.

7 Click [OK].

8 Start printing.

For Mac OS X PS Printer Driver

1 From the [File] menu, select [Page 
Setup].

2 Select a paper size from [Paper Size] 
and then click [OK].

3 From the [File] menu, select [Print].

4 Select [Paper Feed] from the panel 
menu.

5 Select [All] and then select [Multi 
Purpose Tray].

6 Start printing.
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●{ Paper Output

Your printer outputs to the facedown or faceup stacker. Paper types that can be outputted to each 
stacker are as follows.

Output 
Stacker

Supported 
paper type

Paper output 
capacity

Facedown  { Plain paper

 { Recycled 

paper

 { 250 sheets (when 

paper weight is less 

than 80 g/m2)

Faceup  { Plain paper

 { Recycled 

paper

 { Envelope

 { Index card

 { Label

 { 100 sheets (when 

paper weight is less 

than 80 g/m2)

 { 10 sheets (Ultra 

Heavy paper and 

envelopes) 

Note

 { Do not open or close the faceup stacker while printing as 
it may result in a paper jam.

 � Using the Facedown Stacker
Paper is delivered with the print side face down, 
stacked in the order printed. 

Note

 { Check that the faceup stacker (1) on the rear side of the 
printer is closed. If the faceup stacker is open, paper is 
always outputted to the faceup stacker.

1

Memo

 { Open the paper supporter (2) so that the printed papers 
do not fall down from the top cover.

2

 � Using the Faceup Stacker
Paper is delivered with the print side face up, 
stacked opposite the order printed.

1 Pull the faceup stacker (1) on the rear 
side of the printer and open it outward.

1

2 Unfold the paper support (2).

2

3 Open the sub support (3).

3
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●{ Convenient Print Functions

The following convenient print functions are available. For details, refer to the User’s Manual 
(Advanced).

 � Printing on Postcards, Reply 
Postcards or Envelopes

 � Printing on Labels

 � Printing on Custom Size Paper
You can register customized paper sizes to the 
printer driver so you can print on nonstandard 
paper such as banners.

{ Printing on custom size paper
A3

A4

 � Changing the Page Layout
You can change the page layout to multiple print, 
booklet print and poster print etc.

1 2

3 4

12

1 3
5

7
911

1 2

3 4

{Multipie print {Booklet print {Poster print

 � Duplex Printing
You can print on both sides of a sheet of paper.

1

2

{Duplex prints

 � Scaling to Pages
You can print data formatted for one size page 
onto a different size page without modifying the 
print data.

 � Printing Color Data in 
Monochrome

 � Changing Print Quality 
(Resolution)
You can change the print quality to suit your 

needs.

 � Saving Toner
You can save toner by reducing printing density. A 
toner saving can be set in 3 levels.

When printing in 100 % black, you can also 
select the setting without a toner saving. Amount 
of toner can be saved without affecting any 
readability for small characters. 

{Saving toner

Memo

 { There are many convenient print functions in addition to 
those above. Refer to the User’s Manual (Advanced).
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●{ Canceling Printing

Press the <CANCEL> button on the operator 
panel to cancel print jobs being currently printed 
or preparing for a print.

When you press the <CANCEL> button is 
pressed, the following message appears.

To cancel printing, select [Yes] and then press 
the <ENTER> button.

To proceed to printing, select [No] and then 
press the <ENTER> button.

If a printer is not operated for about 3 minutes 
while this message appears, the message will go 
out and printing proceeds.
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●{ Setting the Time that Elapses Before Entering the 
Power Save Mode

Note

 { When a printer is in the power saving mode, press the <POWER SAVE> button to restore from the mode.

 { Check if the message “Ready To Print” appears. If the message is not displayed, press the <ON LINE> button.

1 Press the <Fn> key on the operator 
panel.

2 Enter “200” using the ten-key pad and 
then press the <ENTER> button.

3 Press the scroll button  or  to specify 
the time and then press the <ENTER> 
button.

4 Press the <ON LINE> button.

Memo

 { The power save time can be selected from the followings:

 - [1 minute]

 - [2 minutes]

 - [3 minutes]

 - [4 minutes]

 - [5 minutes]

 - [10 minutes]

 - [15 minutes]

 - [30 minutes]

 - [60 minutes]

 - [120 minutes]
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●{ Setting the Time that Elapses Before Entering the 
Sleep Mode

Note

 { When a printer is in the power saving mode, press the <POWER SAVE> button to restore from the mode.

 { Check if the message “Ready To Print” appears. If the message is not displayed, press the <ON LINE> button.

1 Press the <Fn> key on the operator 
panel.

2 Enter “201” using the ten-key pad and 
then press the <ENTER> button.

3 Press the  or  to specify the time and 
then press the <ENTER> button.

4 Press the <ON LINE> button.

Memo

 { The sleep time can be selected from the followings:

 - [1 minute]

 - [2 minutes]

 - [3 minutes]

 - [4 minutes]

 - [5 minutes]

 - [10 minutes]

 - [15 minutes]

 - [30 minutes]

 - [60 minutes]

 - [120 minutes]
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Constraints When in Sleep Mode

This section explains constraints when in the sleep mode.

The printer may not enter the sleep mode if an error is displayed.

Printer Driver Utility Constraints

When the printer goes into the sleep mode, the following constraints apply to the printer driver and 
utility functions.

When the printer goes into the sleep mode, press the <POWER SAVE> button on the control panel 

and check that the screen displays the message “Ready To Print”.

If the message “Ready To Print” is displayed, the following constraints do not apply.

OS Software Name
Constraints When in the 

Sleep Mode

Method of resolving 
other than to press the 

<POWER SAVE>  
button

Windows Coniguration Tool Cannot specify the network plug-in 
settings.

-

Network Card Setup Cannot search the printer or adjust 
settings.

-

Printer Display Language Setup You cannot change settings when 
there is a USB connection.

Connect to the printer through 
the network.

Driver Installer If there is a connection with the 
network, you cannot automatically 
get printer option information 
when installing a driver.

-

Mac OS X Printer Drivers If there is either a USB or a 
EtherTalk connection, you cannot 
print.

Connect to the printer through 
TCP/IP.

Network Card Setup Cannot search the printer or adjust 
settings.

-



- 79 -

Setting the Time that Elapses Before Entering the Sleep Mode

2

2
. 

P
rin

tin
g
 B

a
s
ic

 O
p
e
ra

tio
n

Network Function Constraints

In the sleep mode, the following constraints 
apply to network functions.

 � Does Not Enter the Sleep Mode
In the following cases, a printer will not enter 
the sleep mode.

 { If IPSec is activated.

 { If NetBEUI is activated.

 { If NetWare is activated.

 { If EtherTalk is activated.

 { If a TCP connection is being established. 
E.g.: If a connection is being established with 
Telnet or FTP. 
In the power save mode, the printer will go 
into the sleep mode if the connection is broken 
after some time passes.

 { When receiving e-mails is activated.

Memo

 { If you want to activate the sleep mode, please deactivate 
IPSec/NetBEUI/NetWare/EtherTalk/receiving e-mail.

 � Cannot Print
In the sleep mode, you cannot print with the 
following protocols.

 { NetBEUI

 { NBT

 { NetWare

 { EtherTalk*

 { Bonjour (Rendezvous)*

* For Mac OS X, you can print while in sleep mode with an IP Print 
connection.

 � Cannot Search/Cannot Specify 
Settings

In the sleep mode, you cannot search or specify 
settings with the following functions or protocols.

 { PnP-X

 { UPnP

 { Bonjour (Rendezvous)

 { LLTD

 { MIB*

* You can reference through some supported MIB in the sleep mode 
(Get command).

 � Protocols with the Client 
Functions Do Not Work

In the sleep mode, the following protocols with 
client functions will not work.

 { E-mail alerts*1

 { SNMP Trap

 { WINS*2

 { SNTP*3

*1 Time that passes in the sleep mode is not included in the interval for periodic notiication by e-mail alert.
*2 Time that passes in the sleep mode is not included in the intervals 

between WINS updates. Regular WINS updates are not carried out 
in the sleep mode, so the names registered on the WINS server 
may be deleted.

*3 Time that passes in the sleep mode is not included in the interval 
between update for NTP servers.

 � Protocols Needing the Sleep Mode 
to be Disabled

When using the following protocols, disable the 
sleep mode.

 { IPv6

 { NetBEUI

 { NetWare

 { EtherTalk

 { Bonjour (Rendezvous)*

* For Mac OS X, you can print while in sleep mode with an IP Print 
connection.
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●{ Settings for Turning Power Off Automatically 
(Auto Power Off)

Note

 { In the factory default, a printer does not enter the auto power off mode while connecting to the network.

Setting the Auto Power Off 
Time

To enable the auto power off mode while 
connecting to the network perform the following 
procedure.

1 Press the <ENTER> button on the 
operator panel.

2 Press the scroll button  several times 
to select [Admin Setup], and press the 
<ENTER> button.

�����������

����� �����

3 Enter the administrator password, using 
the numeric (0-9) keys.

The factory default password is “aaaaaa”. Press 
the <ENTER> button whenever inputting one 
character.

����� � ¡¡¢£�¤

4 Press the <ENTER> button.

5 Press the scroll button  several times 
to select [Power Setup], and press the 
<ENTER> button.

¥¦§¨© ª«¬®
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6 Press the scroll button  several times 
to select [Auto Power Off], and press 
the <ENTER> button.
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7 Press the scroll button  or  to select 
[Enable], and press the <ENTER> 
button.

ñòóô õôö÷ø ùúú
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8 Press the <ON LINE> button to exit the 
menu mode.
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Setting the Time that Elapses Before 
Entering the Auto Power Off Mode

Note

 { When a printer is in the power saving mode, press the 
<POWER SAVE> button to restore from the mode.

 { Check if the message “Ready To Print” appears. If the 
message is not displayed, press the <ON LINE> button.

1 Press the <Fn> key on the operator 
panel.

2 Enter “202” using the ten-key pad and 
then press the <ENTER> button.

3 Press the scroll button  or  to specify 
the time and then press the <ENTER> 
button.

4 Press the <ON LINE> button.

Memo

 { The auto power off time can be selected from the 
followings:

 - [1 hour]
 - [2 hours]

 - [3 hours]

 - [4 hours]

 - [8 hours]

 - [12 hours]

 - [18 hours]

 - [24 hours]
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●{ Setting the Buzzer

You can specify whether to sound a buzzer when an invalid operation is performed on the operation 
panel or when an error occurs.

1 Press the <ENTER> button on the 
operator panel.

2 Press the scroll button  several times 
to select [Admin Setup], and press the 
<ENTER> button.

�����	�
���

���� �����

3 Enter the administrator password, using 
the numeric (0-9) keys.

The factory default password is “aaaaaa”. Press 
the <ENTER> button whenever inputting one 
character.

����� ����� �!

4 Press the <ENTER> button.

5 Press the scroll button  several times 
to select [Buzzer Setup], and press the 
<ENTER> button.

"#$%& '()*+
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6 Press the scroll button  several times 
to select [Invalid Operation Volume] 
or [Error Volume], and press the 
<ENTER> button.

P QRQ

SJJIJ TIUNH

VWXYUZ[ \JGJYMZIW TIU

7 Press the scroll button  several times 
to select a volume level, and press the 
<ENTER> button.

]^_`abc defg`hbi^ j

8 Press the <ON LINE> button to exit the 
menu mode.
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3. Troubleshooting
This chapter provides solutions to the problems you may encounter while operating your printer.

Memo

 { Meanings of symbols in error messages:

 - “%COLOR%” indicates Cyan (C), Magenta (M), Yellow (Y) or Black (K).

 - “%TRAY%” indicates tray 1, tray 2, tray 3, tray 4 or the MP tray.

 - “%COVER%” indicates a front cover or top cover.

 - “%CODE%” indicates a code number displayed in 1 to 3 digits. A code number changes according to an error.

 - “%MEDIA_SIZE%” indicates paper size.

 - “%MEDIA_TYPE%” indicates a paper type.

 { When the message “Please see Help for details” appears on the display screen, you can check an error code and remedy 
error by pressing the <HELP> button on the operator panel.

●{ When an Error Message Appears on the Display 
Screen (When the ATTENTION Indicator Lights 
Up/Blinks)

When a printer problem occurs, an error message appears on the display screen and the 
<ATTENTION> indicator on the operator panel lights up or blinks. Check the error message and deal 
with the problem according to the relevant procedure.

When “Please see Help for details” appears on the display screen, press the <HELP> button to display a 
remedy.

Display Screen when the <HELP> button is pressed

When “Please see Help for details” appears on the display screen, 

press the <HELP> button to display a remedy. Help is not available 

when this message is not displayed.

××××

××××

Error Code

Message on the display screen

Remedy

Scroll display upward

Scroll display downward

<ATTENTION> indicator

××××

Please see HELP for details.

<HELP> button
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●{ When Paper Jams Occurs/When an Error 
Message does not Disappear Even After Jammed 
Paper is Removed

When paper is jammed inside a printer or when an error message does not disappear even after 
jammed paper is removed, an error message appears on the display screen.

Press the <HELP> button to display a remedy. Remove jammed paper according to the remedy 
displayed or the relevant procedure described in the following list.

Display Screen when the <HELP> button is pressed

××××

Scroll display upward

Scroll display downward

Press the <HELP> button to display a remedy.

Message on the display screen (irst line)
Message on the display screen (second line)

××××

××××

Please see HELP for details.

<ATTENTION> indicator

<HELP> button

Error Code

Status Message on the Display Screen

Message displayed 
after the <HELP>  
button is pressed

Reference 
Page

Error Code

Paper jams 1st Line Open Cassette 391, 392, 393, 394 page 92

2nd Line Paper Jam

3rd Line %TRAY%

1st Line Open Cover 372 page 86

2nd Line Paper Jam

3rd Line Front Cover

1st Line Open Cover 380 page 87

2nd Line Paper Jam

3rd Line Front Cover

1st Line Open Cover 390 page 91

2nd Line Paper Jam

3rd Line Front Cover

1st Line Open Cover 381 page 88

2nd Line Paper Jam

3rd Line Top Cover
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Status Message on the Display Screen

Message displayed 
after the <HELP>  
button is pressed

Reference 
Page

Error Code

Paper jams 1st Line Open Cover 382, 383 page 89

2nd Line Paper Jam

3rd Line Top Cover

1st Line Check Duplex Unit 370, 371, 373 page 85

2nd Line Paper Jam

1st Line Check Paper 401 page 87

2nd Line Paper Multi Feed

3rd Line %TRAY%

A message does not 
disappear.

1st Line Open Cassette 631, 632, 633, 634 page 92

2nd Line Paper Remain

3rd Line %TRAY%

1st Line Open Cover 637 page 91

2nd Line Paper Remain

3rd Line Front Cover

1st Line Open Cover 638 page 88

2nd Line Paper Remain

3rd Line Top Cover

1st Line Open Cover 639, 640 page 89

2nd Line Paper Remain

3rd Line Top Cover

1st Line Check Duplex Unit 641, 642 page 85

2nd Line Paper Remain

Error Code 370, 371, 373, 641, 642
A paper jam has occurred around the duplex 
unit.

1 Take out the duplex unit (1) by pulling 
it obliquely upward while holding the 
center recess on the back of printer.

1

2 Check for jammed paper inside the 
printer. If jammed paper remains, 
remove it.

3 Check for jammed paper in the duplex 
unit. If jammed paper remains, pull it 
out gently.
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4 Open the upper duplex unit cover (2) 
and check for jammed paper. If jammed 
paper remains, pull it out gently and 
close the cover.

2

5 Replace the duplex unit (1) into the 
printer.

1

Task is complete.

Error Code 372
A paper jam has occurred around the front 
cover.

1 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

2 Remove the jammed paper gently in 
the direction of the arrow if an edge of 
jammed paper can be seen, and then go to step 8. If you cannot ind jammed 
paper, go to step 3.

3 Take out the duplex unit (3) by pulling 
it obliquely upward while holding the 
center recess on the back of printer.

3

4 Check for jammed paper inside a printer. 
If jammed paper remains, remove it.

5 Check if paper remains in the duplex 
unit. If jammed paper remains, pull it 
out gently.
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6 Open the upper duplex unit cover (4) 
and check for jammed paper. If jammed 
paper remains, remove it, and close the 
cover.

4

7 Replace the duplex unit (3) to the 
printer.

3

8 Close the front cover (2).

2

Error Code 380, 401, 637
A paper jam has occurred around the front 
cover.

1 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

2 Remove the jammed paper gently in the 
direction of the arrow if you can see an 
edge of jammed paper.

3 Close the front cover (2).

2

Task is complete.
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Error Code 381, 638
A paper jam has occurred under an image drum.

1 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

2 Press the top cover open button (3) and 
open the top cover (4).

CAUTION
Possible to get 

burned.

 { The fuser unit is extremely hot. Do not touch 
it.

3

4

3 Remove all four image drums and place them on a lat surface.

4 Cover the removed image drums with 
paper so that the image drums are not 
exposed to light.

5 Pull out the jammed paper gently to the 
rear of the printer (the direction of the 
arrow) if an edge of jammed paper can 
be seen.

Pull out the jammed paper gently while 
lifting the release levers (5) on the fuser 
unit if an edge of jammed paper cannot 
be seen. 

If an edge of jammed paper still remains inside 
the unit, pull out the jammed paper gently to the 
rear of the printer.

5
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6 Return all four image drums into the 
printer carefully.

7 Close the top cover (4) by pushing the both sides of the cover irmly.
4

8 Close the front cover (2).

Note

 { The front cover cannot be closed if the top cover is 
not closed securely.

2

Task is complete.

Error Code 382, 383, 639, 640
A paper jam has occurred around the fuser unit.

1 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

2 Press the top cover open button (3) and 
open the top cover (4).

CAUTION
Possible to get 

burned.

 { The fuser unit is extremely hot. Do not touch 
it.

3

4

3 Remove all four image drums and place them on a lat surface.
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4 Cover the removed image drums with 
paper so that the image drums are not 
exposed to light.

5 Remove the jammed paper remaining 
inside of the unit.

6 Lift the left lock lever (5) of the fuser 
unit forward.

5

7 Hold the fuser unit handle (6) and lift 
the fuser unit out of the printer.

6

8 Lift the release levers (7) on the fuser 
unit, and pull out the jammed paper 
forward gently.

7

9 Hold the fuser unit handle (6) and place 
the fuser unit into the printer.

6
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10 Push the left lock lever (5) of the fuser 
unit backward.

5

11 Return all four image drums into the 
printer carefully.

12 Close the top cover (4) by pushing the both sides of the cover irmly.
4

13 Close the front cover (2).

Note

 { Cannot close the front cover securely if the top cover 
is not closed.

2

Task is complete.

Error Code 390, 637
A paper jam has occurred while feeding paper 
from a paper tray.

1 If there is any paper on the MP tray, lift 
the paper set cover (1) and take it out.

1

2 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (2) to open the 
front cover (3) forward.

2

3
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3 Remove the jammed paper gently by 
pulling the edge of paper.

Remove the paper from the back gently 
if the edge of paper cannot be seen.

4 Close the front cover (3).

3

5 If loading paper on MP tray, lift the 
paper set cover (1) and set the paper 
with the print side face up.

1

6 Lower the paper set cover (1).

1

Task is complete.

Error Code 391, 392, 393, 394, 631, 632, 633, 634
A paper jam has occurred while feeding paper 
from a paper tray.

Note

 { If paper jams occur frequently, clean the paper feed 
rollers. For details, refer to “Cleaning Paper Feed Rollers” 

P.127.

This procedure uses Tray 1 as an example.

1 Gently pull out from the printer the tray 
(1) for which an error is indicated. 

1
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2 Remove the jammed paper.

3 Return the tray (1) to the printer.

1

4 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (2) to open the 
front cover (3) forward.

2

3

5 Close the front cover (3).

3

Task is complete.

Memo

 { Open and close the front cover after removing the 
jammed paper otherwise the error indication do not go 
out.
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●{ When the Message for Replacement of 
Consumables or Maintenance Unit Appears

When the time to replace consumables or maintenance unit is close and replacement must be done, 
the message “…Low”, “…Near Life”, “…Empty”, “…Life”, “Istall…”, “Replace…”, “Change…” 
appears on the display screen and the <ATTENTION> indicator on the operator panel lights up or blinks.

Check the message and replace consumables and maintenance unit.

Display Screen when the <HELP> button is pressed

××××

××××

Scroll display upwards

Scroll display downwards

Press the <HELP> button to display a remedy. 

Message on the display screen (irst line)

Message on the display screen (third line)

Message on the display screen (fourth line)

××××

××××

××××

××××

Please see HELP for details.

<ATTENTION> indicator

<HELP> button

Message on the display screen (second line)

Error Code
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Memo

 { “xxx” described on the list below changes according to the printer status.

Status Message on the Display Screen

Message displayed 
after the <HELP> 
button is pressed

Reference Page or 
Remedy

Error Code

Toner Cartridge 1st Line xxx - Prepare a new toner 
cartridge, and replace the 
old toner cartridge with new 
one after a message for 
replacement of consumables 
or maintenance unit appears.

2nd Line %COLOR% Toner Low

1st Line xxx - page 114

2nd Line %COLOR% Toner Empty

1st Line xxx - page 114

2nd Line %COLOR% Toner Empty

1st Line Install Toner 410, 411, 412 page 117

2nd Line %COLOR% 413 page 115 (Black toner)

1st Line Install Toner Or Press Online 
Button

410, 411, 412 page 114
If a black toner remains, you 
can print in black and white 
by selecting [Monochrome]. 
However, replace the toner 
cartridge soon after it runs 
out. Otherwise, it may cause 
the damage to an image 
drum.

2nd Line %COLOR%

Image Drums 1st Line xxx - Prepare new image drums, 
and replace the old image 
drums with new ones after a 
message for replacement of 
consumables or maintenance 
unit appears.

2nd Line %COLOR% Image Drum Near 
Life

1st Line xxx - page 119

2nd Line %COLOR% Image Drum Life

1st Line xxx - page 119
The number of pages you can 
print is displayed in “nnn”.

2nd Line %COLOR% Image Drum Life, 
%nnn% Pages Left

1st Line xxx - page 119

2nd Line %COLOR% Image Drum Life

1st Line Install New Image Drum 350, 351, 352, 353 page 119
If a toner remains, you can 
continue to print by opening 
or closing the front cover. 
However, replace the toner 
cartridge soon. Otherwise, it 
may cause a decrease in a 
printing quality.

2nd Line Image Drum Life

3rd Line %COLOR%

1st Line Install New Image Drum 560, 561, 562, 565 page 119

2nd Line Image Drum Life

3rd Line %COLOR%

1st Line Install New Image Drum 564, 565, 566, 567 page 119

2nd Line Image Drum Life

3rd Line %COLOR%

4th Line To Exceed the Life, Press 
Online Button
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Status Message on the Display Screen

Message displayed 
after the <HELP> 
button is pressed

Reference Page or 
Remedy

Error Code

Image Drums 1st Line Install New Image Drum 680, 681, 682, 683 page 119

2nd Line Printing disabled due to low 
threshold of Image Drum life.

3rd Line %COLOR%

Fuser Unit 1st Line xxx - Prepare a fuser unit, and 
replace the old fuser unit with 
new one after a message for 
replacement of consumables 
or maintenance unit appears.

2nd Line Fuser Unit Near Life

1st Line xxx - page 124

2nd Line Change Fuser Unit

1st Line Install New Fuser Unit 354 page 124
You can continue to print by 
opening or closing the front 
cover for a while. However 
replace the toner cartridge 
soon. Otherwise, it may cause 
a printer error or paper jam.

2nd Line Fuser Unit Life

Belt Unit 1st Line xxx - Prepare a belt unit, and 
replace the old belt unit with 
new one after a message for 
replacement of consumables 
or maintenance unit appears.

2nd Line Belt Unit Near Life

1st Line xxx - page 122

2nd Line Change Belt Unit

1st Line Install New Belt Unit 355 page 122
You can continue to print by 
opening or closing the front 
cover for a while. However 
replace the toner cartridge 
soon. Otherwise, it may cause 
a printer error.

2nd Line Belt Unit Life
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●{ When the Message for Paper Replacement or 
Paper Size Error Appears

When the media type or media size loaded in a tray does not match the settings speciied in the printer 
driver, the message “Change Paper...” or “Check Paper...” appears on the display screen and the 
<ATTENTION> indicator blinks.

Check the message and deal with the problem. Check the paper size and the settings, refer to “How to 
Print from the Tray” P.64 or “How to Print from the MP Tray” P.65.

Display Screen when the <HELP> button is pressed

××××

××××

Scroll display upward

Scroll display downward

Press the <HELP> button to display a remedy. 

Message on the display screen (irst line)

Message on the display screen (third line)

Message on the display screen (fourth line)

××××

××××

××××

××××

Please see HELP for details.

<ATTENTION> indicator

<HELP> button

Message on the display screen (second line)

Error Code

Status Message on the Display Screen

Message 
displayed after 

the <HELP> 
button is 
pressed

Error Code

Change Paper 1st Line Change Paper in %TRAY% 661, 662, 663, 664

2nd Line %MEDIA_SIZE%

3rd Line %MEDIA_TYPE%

4th Line Press ONLINE Button

1st Line Change Paper in MPTray 660

2nd Line %MEDIA_SIZE%

3rd Line %MEDIA_TYPE%

4th Line Press ONLINE Button

Paper Size does not match print data. 1st Line Change Paper in %TRAY% 461, 462, 463, 464

2nd Line %MEDIA_SIZE%

3rd Line %MEDIA_TYPE%

4th Line Press ONLINE Button

1st Line Change Paper in MPTray 460

2nd Line %MEDIA_SIZE%

3rd Line %MEDIA_TYPE%

4th Line Press ONLINE Button

Paper Size Error 1st Line Check Paper 400

2nd Line Paper Size Error

3rd Line %TRAY%
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●{ Other Error Messages

This section explains the causes and remedies for an error message and the function of the 
<ATTENTION> indicator. An error message appears on the display screen of the operator panel. 

To display an error code, press the <HELP> button on the operator panel.

Error Messages

Error 
code

Message
<ATTENTION> 

indicator
Cause/Remedy

420 Press ONLINE Button for RestorationMemory Overlow Blinks The memory overlowed.
Reduce the data amount. If that does not 
work, reduce the size of the print data.

310
311

Close Cover
%COLOR%

Please see HELP for details

Blinks The cover is open.
Close the cover.
310 : Top cover
311 : Front cover

320
348

Check Fuser Unit

Please see HELP for details

Blinks The fuser unit is not correctly installed.
Install the fuser unit correctly in a printer.

n* Check Data
Message Data Write Error<%CODE%>

Blinks Writing of message data to be uploaded to a 
printer has been failed.

610
611
612
613

Toner Not Installed
%COLOR%

Please see HELP for details

Blinks The toner cartridge of the indicated color 
is not installed correctly. Install the toner 
cartridge correctly.
610 : Yellow (Y)
611 : Magenta (M)
612 : Cyan (C)
613 : Black (K)

544
545
546
547

Check Toner Cartridge
Improper Lock Lever Position
%COLOR%

Please see HELP for details

Blinks The toner cartridge of the indicated color is 
not locked properly.
Turn the blue lever on the right side of the 
cartridge backwards until it stops.
544 : Yellow (Y)
545 : Magenta (M)
546 : Cyan (C)
547 : Black (K)

540
541
542
543

Toner Sensor Error
%COLOR%

Blinks Something is wrong with the toner sensor of 
the indicated color or the image drum is not 
installed correctly.
Install the toner cartridge or image drum of 
the indicated color correctly.
540 : Yellow (Y)
541 : Magenta (M)
542 : Cyan (C)
543 : Black (K)

430
431
432
433
440
441
442

Install Paper Cassette
%TRAY%

Please see HELP for details

Blinks A paper cassette is not in the indicated tray.
Insert the paper cassette into the indicated 
tray.
If the cassette is already inserted in the 
printer, pull out the cassette and set it again 
to correctly locate it.
430, 440 : Tray1
431, 441 : Tray2
432, 442 : Tray3
433 : Tray4
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Error 
code

Message
<ATTENTION> 

indicator
Cause/Remedy

356 Install New Belt Unit
Belt Unit Life

Please see HELP for details

Blinks The belt unit is at the end of its life.
Replace it with a new belt unit.

File System is Full Lights up The ile system is full.
File System is Write Protected Lights up The ile system to which you tried to write is 

write-protected.

330 Check Belt Unit

Please see HELP for details

Blinks The belt unit is not properly installed.
Reinstall it properly.

Deleting Encrypted Job Lights up Deleting an encrypted job.

Print Restricted. Job Rejected

Press ONLINE Button

Lights up A print job sent by a user who is not 
authorized for printing is deleted. 

Color Restricted. Job Rejected

Press ONLINE Button

Lights up A color print job sent by a user who is not 
authorized for color printing is deleted.

Color Restricted. Mono Printed

Press ONLINE Button

Lights up A color print job sent by a user who is not 
authorized for color printing is printed in the 
mono-print mode.

Erased Data Full Lights up Secret ile to be erased are full.
491
492
493
494

Install Paper
%TRAY%
%MEDIA_SIZE%

Please see HELP for details

Blinks The indicated tray is empty.
Load the indicated size paper.
491 : Tray1
492 : Tray2
493 : Tray3
494 : Tray4

File Erasing Lights up Erasing a secret ile.
Error Postscript Blinks A postscript error has occurred.

490 Install Paper
MPTray
%MEDIA_SIZE%
Press ONLINE Button
Please see HELP for details

Blinks Paper in the MP tray is empty.
Load the indicated size paper.

694
696
696
697

Image Drum Not Installed
%COLOR%

Please see HELP for details

Blinks The image drum of the indicated color is not 
installed correctly. Install the image drum 
correctly.
694 : Yellow (Y)
695 : Magenta (M)
696 : Cyan (C)
697 : Black (K)

340
341
342
343

Check Image Drum
%COLOR%

Please see HELP for details

Blinks The image drum of the indicated color is not 
installed correctly. Install the image drum 
correctly.
340 : Yellow (Y)
341 : Magenta (M)
342 : Cyan (C)
343 : Black (K)

nnn* Wait a Moment
Rebooting <n>

Blinks An error has occurred inside the printer. 
The printer is restarted. 1-digit error code 
appears. A code number changes according 
to an error.

%COLOR% Toner Sensor Error Lights up Something is wrong with the toner sensor of 
the indicated color or the image drum is not 
installed correctly.
Install the toner cartridge or image drum of 
the indicated color correctly.
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Error 
code

Message
<ATTENTION> 

indicator
Cause/Remedy

%COLOR% Toner Not Installed Lights up The toner cartridge of the indicated color 
is not installed correctly. Install the toner 
cartridge correctly.

%TRAY% Empty Lights up The indicated tray is empty.
Load the indicated size paper.

Unsupported USB Device Detected

Please detach it

Lights up A USB device unsupported by a printer is 
connected. Remove the device.

Install Paper
MPTray
%MEDIA_SIZE%
Press ONLINE Button

Blinks Load the paper of the size indicated in the 
MP tray, and then press the <ON LINE> 
button.

%COLOR% Waste Toner Full.Replace Toner. Lights up Waste toner is full. Replace with a new toner 
cartridge of the indicated color.

Collate Fail:Too Many Pages

Press ONLINE Button

Lights up A collate print error has occurred.
Reduce the data amount. If that does not 
work, reduce the size of the print data.

File System Operation failed<nnn>

Press ONLINE Button

Lights up An error of ile system for a printer has 
occurred.

Power Off and Wait for a while
126:Condensing Error

Blinks A condensation has occurred inside a printer. 
Turn the printer off and turn on again after 
a while.

Invalid Secure Data

Press ONLINE Button

Lights up Invalid source data is received in an 
authentication printing and deleted.

USB Hub Unsupported

Please detach it

Lights up A USB hub unsupported by a printer is 
connected. Remove the hub.

Log Buffer is Full. Job Rejected

Press ONLINE Button

Lights up Print data is deleted because the accounting 
log buffer is full. Contact a printer 
administrator and remove the log buffer.

360 Install Duplex Unit

Please see HELP for details

Blinks A duplex unit is not installed correctly. 
Install a duplex unit in a printer correctly. 
When a duplex unit is already installed, pull 
out the unit, and then install it again.

nnn* Service Call
nnn: Error

Blinks An error occurred inside the printer. Turn the 
printer off and then on again.

nnn* Power Off/On
nnn:Error
PC:nnnnnnnn
LR:nnnnnnnn
FR:nnnnnnnn

Blinks A fatal error has occurred in a printer. 
Write down the indicated alphanumerical 
characters and contact your dealer.
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●{ When You Cannot Print from the MP Tray

If you print from the MP tray without moving down the paper set cover, the message 
“Install Paper MPTray” appears on the display screen.

Check the message and deal with the problem. Refer to ”How to Print from the MP Tray” P.65.

Paper set cover
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●{ Other Issues

This section explains the issues you may encounter while operating your printer and how to solve them.

Unable to Print from a Computer

Memo

 { If the following information does not solve the issue, contact your dealer.

 { For issues caused by an application, contact the manufacturer of the application.

General Causes

 � Common to Windows and Mac OS X

Cause Remedy Reference

The printer is in the sleep mode. Press the <POWER SAVE> button on the operator 
panel to enter the standby mode.
If the sleep mode is not used, disable it from the 
<ENTER> button > [Admin Setup] > [Power Setup] 
> [Sleep] > [Disable].

page 22

The printer is turned off. Turn on the printer. page 21

An Ethernet or USB cable is unplugged. Check that the cable is plugged into the printer and 
computer properly.

-

Something is wrong with a cable. Replace it with a new cable. -

The printer is off line. Press the <ON LINE> button. -

An error message is displayed on the 
display screen of the operator panel.

“Error Messages” or press the <HELP> button on the 
operator panel.

page 98

The interface setting is disabled. Check the setting of the interface being used from the 
operator panel.

Advanced

Something is wrong with the print 
function.

Check if you can print the contents of the settings. page 30

 � For Windows

Cause Remedy Reference

The printer is not set as the default 
printer.

Set the printer as the default printer. -

The output port for the printer driver is 
incorrect.

Select the output port to which the Ethernet or USB 
cable is connected.

-

A print job from another interface is in 
progress.

Wait until the print job is done. -

“Received invalid data” is displayed on 
the display screen and printing cannot 
be done.

Press the <ENTER> button and select [Menus] > 
[System Adjust] > [Wait Timeout], and then select a 
longer time. The default setting is 40 seconds.

-

A print job is automatically canceled. If using Print Job Control, the print job is not authorized 
to print, or the Job Accounting log buffer may be full.

Advanced
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Network Connection Problems

 � Common to Windows and Mac OS X

Cause Remedy Reference

Using a crossover cable. Use a straight cable. -

The printer is turned on before a cable 
was connected.

Connect cables before turning on the printer. page 32

The hub and the printer are incompatible 
or have some problem.

Press the <ENTER> button and select [Admin Setup] 
> [Network Setup] > [HUB Link Setting], and then 
select [10Base-T Half].

-

It takes much time to print because of 
the hub settings

Press the <ENTER> button > [Admin Setup] > 
[Network Setup] > [TCP ACK] > [Tray2].

-

 � For Windows

Cause Remedy Reference

IP address is incorrect.  { Check that the same IP address is set for the printer 
and the printer's port setting on the computer.

 { If using LPR Utility, check the IP address setting in 
LPR Utility.

-

USB Connection Problems

 � Common to Windows and Mac OS X

Cause Remedy Reference

Unsupported USB cable is being used. Use a USB 2.0 cable. -

A USB hub is being used. Connect the printer directly to the computer. page 52

Printer driver is not installed correctly. Reinstall printer driver. page 52, 
page 54

 � For Windows

Cause Remedy Reference

The printer is off line. Right-click the OKI C831 icon, and then select 
[See what's printing] ([OKI C831(*)] when multiple 
printer drivers are installed). In the dialog box, select 
the [Printer] menu and then remove the check from 
[Use Printer Ofline].

*  Select the type of a printer driver you want.

-

A switch, buffer, extension cable or USB 
hub is being used.

Connect the printer directly to the computer. page 52

A driver for a different printer that uses a 
USB connection has been installed.

Delete the other printer driver from the computer. -
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Unable to Install a Printer Driver Successfully

Memo

 { If the following information does not solve the issue, contact your dealer.

 { For issues caused by an application, contact the manufacturer of the application.

USB Connection Problems

 � For Windows

Cause Remedy Reference

An icon of the printer is not created on 
the [Devices and Printers] folder.

The printer driver is not installed correctly.
Reinstall the printer driver correctly.

page 52

Only the irst printer driver is installed 
even if multiple printer drivers are 
selected to install.

Follow the procedure below to install the second and 
subsequent printer drivers:
1.  Insert the "Software DVD-ROM" into the computer.
2.  Click [Run setup.exe] and follow the on-screen 

instructions.
3.  Select [Custom Installation (Printer)] from 

[Driver Installation].
4.  Click [Next].
5.  Select [Local Printer] and then click [Next].
6.  On the [Printer port] screen, select [FILE] and then 

click [Next].
7.  Complete the setup following the on-screen 

instructions.
8.  In the [Devices and Printers], right-click the 

icon of the second or subsequent driver and select 
[Printer properties] ( [OKI C831(*)] when 
multiple printer drivers are installed).

*Select the type of a printer driver you want.

9.  From the [Ports] tab, select [USBxxx] from the list.
10.  Click [OK].

-

The “Unable to install printer driver” 
error message is displayed.

Use Plug-and-Play. Follow the procedure below.
1.  Ensure that the printer and computer is turned off.
2.  Connect a USB cable.
3.  Turn on the printer.
4.  Turn on the computer.
5.  When the Found New Hardware Wizard is displayed, 

follow the on-screen instructions to complete the 
setup.

For details, refer to [README.TXT] in the "Software 
DVD-ROM".

-
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OS-Speciic Constraints 
Constraints with Windows 7/Windows Vista/Windows Server 2008 R2/Windows Server 2008

Item Symptom Cause/Remedy

Printer drivers [Help] is not displayed. The [Help] function is not supported on PS printer drivers.

The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account 
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

Color Correct 
Utility

The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account 
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

The [Program Capability 
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears 
after an installation (including if you stop an installation 
before it is completed), make sure to click [This program 
installed correctly].

PS Gamma 
Adjuster

The [User Account Control] 
dialog appears.

When you launch an installer or utility, the [User Account 
Control] dialog may appear. Click [Yes] or [Continue] to 
run the installer or utility as an administrator. If you click 
[No], the installer or utility does not start.

The [Program Capability 
Assistant] dialog appears.

If the [Program Capability Assistant] dialog appears 
after an installation (including if you stop an installation 
before it is completed), make sure to click [This program 
installed correctly].

Constraints with Windows Server 2003 Service Pack 1 and Windows XP 
Service Pack 2

 � Constraints with Windows FirewallOn Windows Server 2003 Service Pack 1 and Windows XP Service Pack 2, the Windows irewall 
functionality is enhanced. The following constraints may apply to printer drivers and utilities.

Memo

 { The following procedures are explained using Windows XP Service Pack 2 as an example. The procedure and menu names may 
differ on Windows Server 2003 Service Pack 1.

Item Symptom Cause/Remedy

Printer driver You cannot print a ile when 
using the printer as a shared 
printer on a network.

On the server, click [Start] and then select [Operator 
panel] > [Security Center] > [Windows Firewall].
Select the [Exceptions] tab and select the [File and 
Printer Sharing] check box. Click [OK].

LPR Utility Unable to ind a printer. If the [Don't allow exceptions] check box is selected 
on the [General] tab of the Windows irewall, you cannot 
search for a printer in a segment that is connected to 
another router. Only printers within the same segment as 
the printer can be searched.When you cannot ind a printer, specify the IP address of 
the printer in the [Add Printer] or [Conirm Connections] 
screen.
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Item Symptom Cause/Remedy

Coniguration tool Unable to ind a printer. If the [Don't allow exceptions] check box is selected on 
the [General] tab of Windows Firewall, you cannot search 
for a printer in a segment that is connected to another 
router. Only printers within the same segment as the printer 
can be searched.When you cannot ind a printer, enter the printer name 
(arbitrary) and IP address in [Printer] > [Add or Remove 
Printer] and click [Add].

Image Quality Issues

Memo

 { If the following information does not solve your issues, contact your dealer.

Symptom Point to check Remedy Reference

Vertical lines appear.

Paper feed direction

The LED heads are dirty. Wipe the LED heads with a soft 
tissue paper.

page 129

The toner is low. Replace the toner cartridge. page 114

The image drum is damaged. Replace the image drum. page 119

Foreign materials may be present 
on the image drum.

Replace the image drum. page 119

The light-shielding ilm of the 
image drum is dirty.

Wipe the ilm with a soft tissue 
paper.

-

The image drum is not installed 
properly.

Install the image drum properly. page 119

Printed images are 
fading vertically.

Paper feed direction

The LED heads are dirty. Wipe the LED heads with soft 
tissue paper.

page 129

The toner is low. Replace the toner cartridge. page 114

The paper is unsuitable. Use supported paper. page 59

Printed images are light. The toner save is enabled. Change the toner save settings. -

The toner cartridge is not installed 
properly.

Install the toner cartridge properly. page 114

The toner is low. Replace the toner cartridge. page 114

The paper is moist. Use paper stored in proper 
temperature and humidity 
conditions.

page 59

The paper is unsuitable. Use supported paper. page 59

The paper is unsuitable.
The settings of media type and 
weight are incorrect.

Press the <ENTER> button 
and select [Menus] > [Tray Coniguration] > the paper tray coniguration you are using, and 
then select the proper values 
for [Media Type] and [Media 
Weight]. Or, select a larger value 
for [Media Weight].

page 59

The paper is recycled. 
The media weight setting is 
unsuitable.

Press the <ENTER> button 
and select [Menus] > [Tray Coniguration] > the paper tray 
you are using, and then select a 
larger value for [Media Weight].

page 59
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Symptom Point to check Remedy Reference

Printed images are 
partially faded. Spots 
and lines appear.

The paper is too moist or dry. Use paper stored in proper 
temperature and humidity 
conditions.

page 59

[Paper Black Setting] or 
[Paper Color Setting] is improperly conigured.

Press the <ENTER> button 
and select [Menus] > [System 
Adjust], and then change the 
value for [Paper Black Setting] 
or [Paper Color Setting].

-

[Trans. Black Setting] or 
[Trans. Color Setting] is improperly conigured.

Press the <ENTER> button and
select [Menus] > [System 
Adjust], and then change the 
value for [Trans. Black Setting] 
or [Trans. Color Setting].

-

Horizontal lines 
and spots appear 
periodically.

Paper feed direction

If the interval of lines or spots 
is about 94 mm (4 inches), the 
image drum (the green tube) is 
damaged or dirty.

Lightly wipe the image drum with 
soft tissue paper.
Replace the image drum if it is 
damaged.

page 119

If the interval of lines or spots is 
about 30 mm (1.5 inches), foreign 
materials may be present on the 
image drum.

Open and close the top cover, and 
print again.

-

If the interval of lines or spots is 
about 143 mm, there is damage to 
the fuser unit.

Change the fuser unit. page 124

The image drum has been exposed 
to light.

Place the image drum back into 
the printer and leave it for a few 
hours. If that does not solve the 
problem, replace the image drum.

page 119

The paper feed path is dirty. Print a few test copies. -

White area of paper is 
lightly stained.

The paper contains static 
electricity.

Use paper stored in proper 
temperature and humidity 
conditions.

page 59

The paper is too thick. Use thinner paper. -

The toner is low. Replace the toner cartridge. page 114

Periphery of letters is 
smudged.

The LED heads are dirty. Wipe the LED heads with soft 
tissue paper.

page 129

The paper is unsuitable. Use recommended paper. -

The paper is moist. Replace it with new paper. page 59

The entire paper area 
is lightly stained when 
printing on envelopes or 
coated paper.

The toner may be sticking to the 
whole area of the envelope or 
coated paper.

This is not a malfunction of the 
printer.
Coated paper is not recommended.

-
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Symptom Point to check Remedy Reference

Toner comes off when it 
is rubbed.

The settings of media type and 
weight are incorrect.

Press the <ENTER> button 
and select [Menus] > [Tray Coniguration] > the paper tray coniguration you are using, 
and then select the proper 
values for [Media Type] and 
[Media Weight]. Or, select a 
heavier weight in [Media Weight].

page 59

The paper is recycled.
The media weight setting is 
unsuitable.

Press the <ENTER> button 
and select [Menus] > [Tray Coniguration] > the paper tray coniguration you are using, and 
then select a heavier weight for 
[Media Weight].

page 59

Glossiness is not 
uniform.

The settings of media type and 
weight are incorrect.

Press the <ENTER> button 
and select [Menus] > [Tray Coniguration] > the paper tray coniguration you are using, 
and then select the proper 
values for [Media Type] and 
[Media Weight]. Or, select a 
heavier weight in [Media Weight].

page 59

Color of the printed 
image is not what you 
expect.

The toner is low. Replace the toner cartridge. page 114

The setting of [Black Finish] is 
not suitable for the application.

On the printer driver, select 
[Composite Black (CMYK)] 
of [True Black (K)] for [Black 
Finish].

Advanced

The color adjustment has been modiied. Do color matching from the printer 
driver.

Advanced

The color balance is out of 
adjustment.

Press the <ENTER> button and 
select [Calibration], and then 
[Adjust Density].

Advanced

Color registration is out of 
alignment.

Open and close the top cover.
Or, press the <ENTER> button 
and select [Calibration], and then 
[Adjust Registration].

Advanced

Solid printing of CMY 
100% is too light.

[CMY100% Density] is set to 
[Disable].

Press the <ENTER> button 
and select [Admin Setup] > 
[Color Setup] > [CMY100% 
Density], and then select 
[Enable].

-

Dots appear. The paper is unsuitable. Use supported paper. page 59

When the interval of the dots 
is about 94 mm (4 inches), the 
image drum (the green tube) is 
damaged or dirty.

Lightly wipe the image drum with a 
soft tissue paper.
Replace the image drum when it is 
damaged.

page 119

Smears is printed. The paper is moist. Replace it with new paper. page 59

The paper is unsuitable. Use supported paper. page 59
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Symptom Point to check Remedy Reference

The background of a 
printed page is dark or 
dirty.

The printer may be malfunctioning. Contact your dealer. Back cover

Nothing is printed.

?

Two or more sheets of paper are 
fed simultaneously.

Fan the paper well and load it 
again.

page 64, 
page 65

The printer may be malfunctioning. Contact your dealer. -

Patches appear. The paper is moist. Replace it with new paper. page 59

The paper is unsuitable. Use supported paper. page 59

Feeding Issues

Memo

 { If the following information does not solve the issue, contact your dealer.

Symptom Point to check Remedy Reference

 { The paper often 
jams.

 { Multiple sheets 
are fed at once.

 { The paper is fed 
at an angle.

The printer is tilted. Place the printer on a lat surface. page 16

The paper is too light or too heavy. Use the appropriate paper for the 
printer.

page 59

The paper is moist or has a static 
charge.

Use paper stored in proper 
temperature and humidity 
conditions.

page 59

The paper is wrinkled, folded or 
curled.

Use appropriate paper for the printer. 
Fix the curled paper.

page 59

Something is already printed on the 
back side of the paper.

With tray 1/2/3/4, you cannot use 
paper that has been printed.
Load it on the MP tray for printing.

page 65

The edges of the paper are not kept 
even.

Fan the paper and even up the 
edges.

page 64, 
page 65

There is only one sheet of paper in 
the tray.

Load several sheets of paper. page 64, 
page 65

You have added more paper with 
paper already loaded in the tray.

Remove the already loaded paper, 
stack it onto the new paper, even up 
the edges and load the paper with 
the old paper on top.

page 64, 
page 65

The paper is loaded at an angle. For tray 1/2/3/4, adjust the paper 
width guide and stopper to the 
paper.
For the MP tray, adjust the paper 
width guide to the paper.

page 64, 
page 65

Envelopes are not correctly loaded. Load envelopes correctly. page 65

Paper, envelopes or labels of weight 
between 177 and 220 g/m2 is loaded 
in tray 1 and tray 2.

Load the paper, envelopes or labels 
of weight between 177 and 220 g/m2 
on the MP tray, and use the face up 
stacker.

page 59, 
page 65
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Symptom Point to check Remedy Reference

Paper does not feed 
into the printer.

The setting of [Source] in the 
printer driver is not correctly speciied.

Check the paper tray and select 
the correct tray in [Source] in the 
printer driver.

-

You have speciied manual feeding 
on the printer driver.

In the printer driver, clear the [Use 
MP tray as manual feed] check 
box on [Paper feed options].

Advanced

The printer does 
not start processing 
even though you 
have removed the 
jammed paper.

- Open and close the top cover. -

The paper gets 
folded or wrinkled.

The paper is moist or has a static 
charge.

Use paper stored in proper 
temperature and humidity 
conditions.

page 59

The paper is light. Press the <ENTER> button 
and then select [Menus] > 
[Tray Coniguration] > [(tray name) Conig] > [Media Weight].
Then, specify a lighter weight.

page 59

The paper twists 
around the rollers 
in the fuser unit.

The settings of media weight and 
type are incorrect.

Press the <ENTER> button 
and then select [Menus] > 
[Tray Coniguration] > [(tray name) Conig] > [Media Type]/ 
[Media Weight]. Then, specify the 
appropriate values.
Or, specify a heavier weight in 
[Media Weight].

page 59

The paper is light. Use heavier paper. -

There is an image or text on the 
leading edge of the paper.

Add a margin on the leading edge of 
the paper.
For duplex printing, leave a margin 
in the leading and bottom edges.

-

Machine Issues

Symptom Point to check Remedy Reference

You turned on the 
printer, but nothing 
displays on the 
screen.

The AC cord is unplugged. Turn off the printer and then plug in the AC cord irmly. -

The power is out. Check if the power is being supplied 
to the electric outlet.

-

The printer does 
not operate.

The AC cord is not irmly plugged in. Plug in the AC cord irmly. -

The printer is turned off. Turn on the printer. page 21

The printer turned off automatically 
by the auto power off function.

Disable the auto power off function. page 80

Printer does not answer. Hold down the power switch for more 
than 5 seconds to turn off the printer 
forcibly. 

-
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Symptom Point to check Remedy Reference

The printer does 
not start printing.

An error is displayed on the panel. Check the error code and follow the 
on-screen instructions.

page 98

The Ethernet or USB cable is 
unplugged.

Plug in the Ethernet or USB cable irmly. page 32, 
page 52

Something is wrong with the 
Ethernet or USB cable.

Use another Ethernet or USB cable. -

The printer does not support your 
Ethernet or USB cable.

 { Use a USB 2.0 compatible cable.
 { Use an Ethernet 10BASE-T 
/100BASE-TX compatible cable.

-

Something may be wrong with the 
printing function.

Press the <ENTER> button and 
select [Print Information] > 
[Coniguration] and then print the 
contents of the settings to check the 
printing function.

page 30

The interface is disabled. Press the <ENTER> button and 
select [Admin Setup] > [Network 
Setup] and enable the interface you 
are using.

-

The printer driver of the printer is 
not selected.

Set the printer driver of the printer 
as the default printer.

-

The speciied port of the printer 
driver is wrong.

Specify the port the Ethernet or USB 
cable is connected to.

-

The display screen 
is blank.

The printer is in the sleep mode. Check if the <POWER SAVE> 
button lights up and press the 
<POWER SAVE> button to activate 
the printer.

page 22

Print data is not 
transmitted to the 
printer.

The Ethernet or USB cable is broken. Connect a new cable. -

The time-out period set on the 
computer has passed.

Set a longer time-out period. -

There is an 
abnormal sound.

The printer is tilted. Place the printer on a lat surface. -

There is a piece of paper or foreign 
object inside the printer.

Check the inside of the printer and 
remove any objects.

-

The top cover is open. Close the top cover. -

There is a buzzing 
sound.

The printer is printing on the heavy 
or thin paper when the temperature 
inside is high.

This is not a malfunction. You can 
proceed with the operation.

-

It takes a while to 
start printing.

The printer is warming up from the 
power save or sleep mode.

Press the <ENTER> button 
and select [Admin Setup] > 
[Power Setup] > [Power Save]/ 
[Sleep] and disable both modes.

page 22

The printer may be cleaning the 
image drum.

Wait for a while. -

The printer is adjusting the 
temperature of the fuser unit.

Wait for a while. -

The printer is processing data from 
another interface.

Wait until the process inishes. -

A print job has 
stopped in the 
middle of the 
printing process.

As a result of processing print jobs 
continuously for a long time, the 
inside the printer has become hot. 
The printer is cooling off.

Wait for a while.
When the fuser unit becomes cooler, 
printing restarts automatically.

-

As a result of processing print jobs 
continuously for a long time, the 
temperature in the printer inside 
has become too high. The printer is 
cooling off.

Wait for a while.
When the printer becomes cooler, 
printing restarts automatically.

-

When the print processing is 
overloaded by printing with the WSD 
port, a computer may stop sending.

Retry to send data on a computer. If 
the error is not resolved, use other 
network port.

-

Memory is insuficient. A printer is short on memory 
because print data is too large.

Reduce print data with a printer 
driver.

Advanced
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Symptom Point to check Remedy Reference

It takes a long time to inish printing. The processing speed of the 
computer may be slowing down the 
print job.

Use a computer with faster 
processing speed.

-

You have selected [ProQ/High 
Quality] on the [Job Options] tab 
of the printer driver.

Select [Fine / Detail (600x1200)] 
or [Normal (600x600)] on the 
[Job Options] tab of the printer 
driver.

-

The print data is complex. Make the data simpler. -

Paper is narrow (less than 230 mm). Change the mode. Advanced

The printer driver 
is not correctly 
displayed on Mac 
OS X.

The printer driver may not be 
operating correctly.

Uninstall the printer driver and install 
it again.

Advanced

Paper is curled. Thin paper is used. Set an appropriate paper weight or 
select [High Humid Mode].

Advanced

Paper is wet on the 
edge.

Wet paper is used. Select [High Humid Mode]. Advanced

The LED indicator
in the power switch
is blinking at high
speed per about
0.3 seconds.

The printer may be malfunctioning.
 Unplug the AC cord immediately.

-
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4. Maintenance
This chapter explains how to replace consumables and maintenance units, clean the printer, and move 
or transport the printer.

●{ Replacing Consumables and Maintenance Units

This section explains how to replace consumable items.

WARNING

Do not throw the toner or toner cartridge into the ire. 
Doing so may cause toner 
splashes leading to burns.

Do not keep the toner 
cartridge in places close to the ire. It may catch the ire, which cause ire and 
burns.

Do not vacuum spilled toner 
powder. If vacuuming, it may 
cause ignition due to the 
sparks from electric contacts. Toners spillage on the loor 
should be wiped off by wet 
clothes.

CAUTION

There are high temperature 
parts in the device. Do 
not touch the periphery 
of the label "Caution High 
Temperature", which may 
cause burns.

Keep the toner cartridge out 
of reach of young children. If 
young children swallow toner 
powder, follow the doctor's 
direction immediately.

If toner powder is inhaled, 
gargle with large amounts of 
water and move the person 
to the open area for fresh air. 
Follow the doctor's direction 
if necessary.

If the toner powder sticks to 
your skin like your hands, 
wash with soap.

If the toner gets into the eyes, lush with plenty of 
water immediately. Follow 
the doctor's direction if 
necessary.

If you swallow toner powder, 
take large amounts of water 
to weaken the toner. Follow 
the doctor's direction if 
necessary.

When handling a paper 
jam, or replacing the toner 
cartridge, make sure not to 
get your cloth and hands 
dirty. When toner powder 
stains on your cloth, wash 
with cold water. If you wash 
with hot water, the toner 
may be soaked into the cloth; it may be dificult to 
clean.

Do not disassemble the toner 
cartridge. Toner powder may ly upward, and you may 
inhale the toner powder 
or may get your cloth and 
hands dirty.

Keep a used toner cartridge 
in a bag so that the toner powder can not ly upward.

Note

 { Use only genuine Oki Data consumable items to ensure optimum quality.

 { Service for problems due to use of consumable items other than genuine OKI consumables will incur fees even in the warranty 
period or the maintenance contract period.



- 114 -

Replacing Consumables and Maintenance Units

4

4
. 

M
a
in

te
n
a
n
c
e

Replacing Toner Cartridges

Note

 { Toner powder may spill if you remove a toner cartridge 
before the toner runs out.

Life Span of Toner Cartridge

When the “%COLOR% Toner Low” message 
(“%COLOR%” indicates C (cyan), M (magenta), 
Y (yellow) or K (black)) appears on the display 
screen, prepare a replacement toner cartridge. 
You can keep printing approximately 250 pages 
until the next message appears.

When the “%COLOR% Toner Empty” appears 
and printing is stopped, replace the toner 
cartridge.

Memo

 { Even if the cyan (blue), magenta (red) or yellow toner 
cartridges run out, you can print in black and white by 
selecting [Monochrome] or [Grayscale]. However, 
please replace the toner cartridge quickly after it runs 
out, as not doing so may cause the image drum to be 
damaged.

The life expectancy of toner cartridges is as 
follows (for A4 simplex printing with default 
density, according to ISO/IEC 19798).

The starter toner cartridge is the toner cartridge 
that comes with the product at the time of 
purchase.

 { When replacing a toner cartridge

Type Number of printable pages

Starter toner 
cartridge

C, M, Y, K 2500 pages

Toner cartridge C, M, Y, K 10000 pages

Note

 { The actual life of the toner cartridge differs depending on 
the usage.

Note

 { Have a new print cartridge ready, as the print quality 
declines after more than one year following breaking the 
seal.

 { If you replace the toner cartridge/image drum while it is 
being used, the amount of toner used will not be counted 
normally.

 { By opening and closing the top cover after the message 
“Color toner has run out” is displayed, you are able 
to print approximately 100 copies of A4 size ISO test patterns (approximately 20 pages, ive times). However 
further printing operations will not be possible after that. 
Please replace the toner cartridge as failure to do so may 
damage the image drum.
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Procedure for Replacement  
(for K (black) Toner Cartridge)

Memo

 { When replacing the C, M, Y toner cartridges, refer to 
“Procedure for Replacement  
(for C (cyan), M (magenta), 
 Y (yellow) Toner Cartridges)” P.117.

1 Prepare a new [K] toner cartridge.

2 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

3 Turn the blue lever (3) of the toner 
cartridge.

3

4 Lift the toner cartridge (4) from the right 
side, and remove it from the printer.

WARNING
Possible to get 

burned.

 { Do not throw a used toner cartridge in the ire. They may explode, and the toner inside may ly off and cause getting burned.
Note

 { When toner powder adheres to the paper feeding area 
inside the printer, wipe it off with a wet cloth that has 
been well wrung.

4

➊

➋

➌

5 Leaving the replacement toner cartridge 
in its bag, gently shake it up and down 
and side to side, and then unpack it.

6 Remove the tape (5) from the toner 
cartridge.

5
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7 Insert a new toner cartridge (6) by 
aligning its left side indentation (7) with 
the protrusion (8) on the image drum so 
the toner cartridge and image drum [K] color label align. Then ix the right side irmly into place.

Note

 { Do not insert a toner cartridge without removing the 
tape.

6

8
7

➊

➋

8 Turn the blue lever (3) of the toner 
cartridge in the direction of the arrow 
fully while pressing the top of the toner 
cartridge.

3

9 Close the front cover (2).

Note

 { The front cover cannot be closed if the top cover is 
not closed securely.

2

10 Please recycle toner cartridges.

Memo

 { If you must dispose of a toner cartridge, put it in a plastic 
bag or similar container and dispose of it in accordance 
with your municipality’s ordinances or guidelines.
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Procedure for Replacement  
(for C (cyan), M (magenta), 
 Y (yellow) Toner Cartridges)

Memo

 { When replacing the K toner cartridge, refer to “Procedure 
for Replacement  
(for K (black) Toner Cartridge)” P.115.

1 Prepare new toner cartridges.

2 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

3 Press the top cover open button (3) and 
open the top cover (4).

CAUTION
Possible to get 

burned.

 { The fuser unit is extremely hot. Do not touch 
it.

3

4

4 Identify an empty toner cartridge by its 
label color (5).

5

5 Slide the right blue lever (6) of the toner 
cartridge while pressing the top of the 
cartridge to unlock.

6

6 Lift the toner cartridge (7) from right 
side, and remove it from the printer.

WARNING
Possible to get 

burned.

 { Do not throw a used toner cartridge in the ire. They may explode, and the toner inside may ly off and cause getting burned.

7

➊

➋

➌
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7 Unpack the replacement toner cartridge, 
and gently shake it up and down and 
side to side.

8 Remove the tape (8) from the toner 
cartridge.

8

9 Insert a new toner cartridge (9) by 
aligning its left side indentation (10) 
with the protrusion (11) on the image 
drum so the toner cartridge and image drum color labels align. Then ix the right side irmly into place.

Note

 { Do not insert a toner cartridge without removing the 
tape.

1011

➊

➋

9

10 Turn the blue lever (6) of the toner 
cartridge in the direction of the arrow 
fully while pressing the top of the toner 
cartridge.

6

11 Close the top cover (4) by pushing the both sides of the cover irmly.
4

12 Close the front cover (2).

2

Note

 { The front cover cannot be closed if the top cover is 
not closed securely.

13 Please recycle toner cartridges.

Memo

 { If you must dispose of a toner cartridge, put it in a plastic 
bag or similar container and dispose of it in accordance 
with your municipality’s ordinances or guidelines.



- 119 -

Replacing Consumables and Maintenance Units

4

4
. 

M
a
in

te
n
a
n
c
e

Replacing the Image Drum

Life Span of Image Drum

When the “%COLOR% Image Drum Near 
Life” message appears on the display screen, 
prepare a replacement image drum. 
If you continue printing, the message 
“%COLOR% Image Drum Life” will be 
displayed and printing will stop.

A guideline for replacing the image drum is 
every 30,000 pages or so for A4 sized paper 
(with single-sided printing). However, this 
number of pages is for common printing 
conditions (3 pages at a time). Printing one page 
at a time reduces the drum life by about half.

The actual number of printed pages may be 
halved again relative to the above guideline, 
depending on the printing conditions.

If you continue to print more than the above, 
the printer will force the printing to stop.

Note

 { The actual number of pages you can print with the image 
drum depends on how you use it. The above guideline 
may be reduced by more than half, depending on the 
conditions of printing.

 { Though opening and closing the top cover may extend 
the life of a image drum for a while, it is recommended to 
replace it soon after the “Install New image drum” is 
displayed.

 { The print quality may deteriorate after the toner cartridge 
has been unpacked for a year. Replace it with a new one.

 { When the <ENTER> button > [Admin Setup] > 
[System Setup] > [Near Life Status] is set to 
[Disable], the “%COLOR% Image Drum Near Life” 
message does not appear.

Procedure for Replacement

Note

 { If you use a new image drum with the toner cartridges 
currently in use, the remaining amount indication of the 
toner cartridges will not display correctly. 
The messages “%COLOR% Image Drum Near Life” or 

“%COLOR% Image Drum Life” may also be displayed 
soon after replacement.

 { The image drum (the green tube) is very delicate. Handle 
it carefully.

 { Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

 { In order for the printer to exhibit its full performance, 
please use genuine Oki Data consumables.

 { Service for problems due to use of consumable items 
other than genuine OKI consumables will incur fees 
even in the warranty period or the maintenance contract 
period. (Use of consumable items other than genuine OKI 
consumables does not always cause problems, but please 
exhibit caution when using those.)

 { There is one toner cartridge for each color on the image 
drum.

1 Prepare a new image drum.

2 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

3 Press the top cover open button (3) and 
open the top cover (4).

CAUTION
Possible to get 

burned.

 { The fuser unit is extremely hot. Do not touch 
it.

3

4

4 Identify an empty toner cartridge by its 
label color (5).

5
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5 Remove the image drum (6) from the 
printer in the direction of the arrow and place the image drum on a lat surface.

6

6 Turn the right blue lever (7) of the toner 
cartridge forward while pressing the top 
of the toner cartridge to unlock.

7

7 Lift the toner cartridge (8) from the 
right side, and remove it from the image 
drum.

WARNING
Possible to get 

burned.

 { Do not throw a used image drum and toner cartridge in the ire. They may explode, and the toner inside may ly off and cause getting 
burned.

8

➋

➊

8 Remove the protective sheets. Place a new image drum (9) on a lat 
surface.

9

9 Remove the toner cover (10).

10

10 Insert the toner cartridge (8) taken 
out in step 7 to the image drum (9) by 
aligning its left side indentation (11) 
with the protrusion (12) on the image drum, and then ix the right side irmly 
into place.

8

12

9

11

➋

➊
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11 Turn the blue lever (7) of the toner 
cartridge in the direction of the arrow 
fully while pressing the top of the toner 
cartridge.

7

12 Check a label color of a new image drum 
(9) and place the drum into a printer.

9

13 Close the top cover (4) by pushing the both sides of the cover irmly.
4

14 Close the front cover (2).

Note

 { The front cover cannot be closed if the top cover is 
not closed securely.

2

15 Please recycle image drums.

Memo

 { If you must dispose of an image drum, put it in a plastic 
bag or similar container and dispose of it in accordance 
with your municipality’s ordinances or guidelines.

 { If the light-shielding ilm of the image drum becomes dirty, wipe the ilm by following the procedures below.
(1) Open the front cover.

(2) Open the top cover.

(3) Remove the image drum.

(4) Wipe the light-shielding ilm with soft 
tissue paper.

(5) Put the image drum back to the 
printer.

(6) Close the top cover by pushing the both sides of the cover irmly.
(7) Close the front cover.
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Replacing the Belt Unit

Life Span of Belt Unit

When the “Belt Unit Near Life” message 
appears on the display screen, prepare a 
replacement belt unit. You can keep printing 
approximately 1000 pages until the next 
message appears.

When the “Change Belt Unit” message 
appears, replace the belt unit.

The life expectancy of the belt unit is 
approximately 80,000 pages for A4 simplex 
printing (three pages per job).

Note

 { The actual number of pages you can print with the belt 
unit depends on how you use it.

Note

 { Though opening and closing the top cover may extend 
the life of the belt unit somewhat, you should replace it 
soon after the “Change Belt Unit” is displayed to prevent 
malfunction.

 { If you replace the belt unit, use it until the end of its 
useable life. If you remove the belt unit and install and 
use another one before its usable life has expired, the use 
life will not be correctly displayed.

 { When the <ENTER> button > [Admin Setup] > 
[System Setup] > [Near Life Status] is set to 
[Disable], the [Belt Unit Near Life] message does not 
appear.

Procedure for Replacement

Note

 { The image drum (the green tube) is very delicate. Handle 
it carefully.

 { Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

1 Prepare a replacement belt unit.

2 Turn off your printer by pressing the 
power switch.

Reference

 { “Turning Off the Power” P.22

3 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

4 Press the top cover open button (3) and 
open the top cover (4).

CAUTION
Possible to get 

burned.

 { The fuser unit is extremely hot. Do not touch 
it.

3

4

5 Take all the four image drums out of a printer, and then place them on a lat 
surface.
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6 Cover the image drums you took out 
with paper so that the image drums do 
not expose to the light.

7 Turn the blue locks (5) on each side of 
the belt unit in direction of the arrow to 
unlock.

5

5

8 Remove the belt unit by holding the blue 
lever (6).

6

9 Hold the handle of a new belt unit with 
one hand and support lower part with 
other hand. Place the belt unit into the 
printer.

➌ ➊

➋

➍

10 Turn the blue locks (5) on each side of 
the belt unit in direction of the arrow.

5

5
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11 Return all the four image drums to the 
printer.

12 Close the top cover (4) by pushing the both sides of the cover irmly.
4

13 Close the front cover (2).

Note

 { The front cover cannot be closed if the top cover is 
not closed securely.

2

14 Please recycle belt unit.

Memo

 { If you must dispose of a belt unit, put it in a plastic bag or 
similar container and dispose of it in accordance with your 
municipality’s ordinances or guidelines.

Replacing the Fuser Unit

Life Span of Fuser Unit

When the “Fuser Unit Near Life” message 
appears on the display screen, prepare a 
replacement fuser unit. You can keep printing 
approximately 1250 pages until the next 
message appears.

When the “Change Fuser Unit” message 
appears, replace the fuser unit.

The life expectancy of the fuser unit is up to 
100,000 pages for A4 simplex printing.

Note

 { The actual number of pages you can print with the fuser 
unit depends on how you use it.

Note

 { Though opening and closing the top cover may extend 
the life of the fuser unit somewhat, you should replace it 
soon after “Change Fuser Unit” is displayed to prevent 
malfunction.

 { If you replace the fuser unit, use it until the end of its 
useable life. If you remove the fuser unit and install and 
use another one before its usable life has expired, the use 
life will not be correctly displayed.

 { When the <ENTER> button > [Admin Setup] > 
[System Setup] > [Near Life Status] is set to 
[Disable], the [Fuser Unit Near Life] message does not 
appear.

Replacement Procedure

Note

 { Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

1 Prepare a new fuser unit.

2 Turn off your printer by pressing the 
power switch.

Reference

 { “Turning Off the Power” P.22
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3 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

4 Press the top cover open button (3) and 
open the top cover (4).

CAUTION
Possible to get 

burned.

 { Since the fuser unit gets hot, carry out the 
operation carefully, and when lifting it up you 
must hold it by the handle. Do not try to hold 
it whilst it is hot.  Wait until it has cooled 
down and then carry out the operation.

3

4

5 Pull forward the left locking lever (5) of 
the fuser unit to unlock.

5

6 Hold the fuser unit handle (6) and lift 
the fuser unit out of the printer.

6

7 Hold the fuser unit handle (6) and place 
the fuser unit into the printer.

6

8 Push back the left locking lever (5) of 
the fuser unit to lock.

5
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9 Close the top cover (4) by pushing the both sides of the cover irmly.
4

10 Close the front cover (2).

Note

 { The front cover cannot be closed if the top cover is 
not closed securely.

2

11 Please recycle fuser unit.

Memo

 { If you must dispose of a fuser unit, put it in a plastic bag 
or similar container and dispose of it in accordance with 
your municipality’s ordinances or guidelines.
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●{ Cleaning

This section explains how to clean each part of your printer.

Cleaning the Surface of the 
Printer

Note

 { Do not use benzine, thinners, or alcohol as a cleaning 
agent. They may damage the plastic parts of the printer.

 { Do not lubricate your printer with oil.

1 Turn off your printer by pressing the 
power switch.

Reference

 { “Turning Off the Power” P.22

2 Wipe the surface of the printer with a 
soft cloth lightly moistened with water or 
neutral detergent.

3 Dry the surface of the printer with a dry 
soft cloth.

Cleaning Paper Feed Rollers

Clean the paper feed rollers if paper jams occur 
frequently.

Note

 { You should replace the paper feed rollers if paper jams 
keep occurring even after cleaning the paper feed rollers.

For Tray 1/2/3/4
Memo

 { This procedure images use tray 1 as an example, but the 
same procedure applies to tray 2/3/4.

1 Pull out the tray (1).

1

2 Wipe the two paper feed rollers (2) 
inside the printer with a wet cloth that 
has been wrung out well.

2

3 Remove paper loaded in the tray.

4 Wipe the paper feed roller (3) on the 
tray with a wet cloth that has been 
wrung out well.

3

5 Load paper in the tray.

6 Push the tray back into the printer.

For MP Tray

1 Open the MP tray (1) forward by inserting your ingers into the front 
recesses (2).

2

2

1
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2 Release the tab (3) of the paper feed 
roller cover by pressing the right arm (4) 
inward while lifting up the MP tray (1) 
lightly.

1

4

3

3 Also press the left arm (4) inward while 
lifting up the MP tray (1) lightly to 
release the tab (3) of the paper feed 
roller cover.

1

4

3

4 Open the paper set cover (5) until 
touching the printer.

5

5 Wipe the two paper feed rollers (6) with 
a wet cloth that has been wrung out 
well.

6

6 Open the separation roller cover (7) 
forward while pressing the center part of 
the MP tray. 
Wipe the two separation roller (8) with a 
wet cloth that has been wrung out well.

7

8

7 Close the separation roller cover (7).

7

8 Lower the paper set cover (5).

5
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9 Hook one tab (3) of the paper feed roller 
cover by pressing the right arm (4) 
inward while lifting up the MP tray (1) 
lightly.

Note

 { If closing the MP tray without returning the tab to the 
correct position, the paper set cover may be broken. 
Be sure to return the tab to the original position.

1

4

3

10 Also hook the other tab (3) of the paper 
feed roller cover by pressing the left arm 
(4) inward while lifting up the MP tray 
(1) lightly.

Note

 { If closing the MP tray without returning the tab to the 
correct position, the paper set cover may be broken. 
Be sure to return the tab to the original position.

1

4

3

11 Close the MP tray (1).

If the MP tray cannot be closed, return the paper 
set cover to the correct position by pressing the 
paper loading part on the MP tray downward.

1

Cleaning LED Heads

Clean the LED heads if vertical lines appear, 
images are fading vertically, or the periphery of 
letters is smudged in the printouts. Dirt on the 
LED heads may also cause paper jams.

Note

 { Do not use methyl alcohol or thinners as a cleaning agent. 
They may damage the LED heads.

 { Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

1 Turn off your printer by pressing the 
power switch.

Reference

 { “Turning Off the Power” P.22

2 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

3 Press the top cover open button (3) and 
open the top cover (4).

CAUTION
Possible to get 

burned.

 { The fuser unit is extremely hot. Do not touch 
it.

3

4
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4 Lightly wipe the lenses (5) of the LED 
heads with soft tissue paper.

5

5 Close the top cover (4) by pushing the both sides of the cover irmly.
4

6 Close the front cover (2).

Note

 { The front cover cannot be closed if the top cover is 
not closed securely.

2
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●{ Moving or Transporting Your Printer

This section explains how to move or transport your printer.

Moving Your Printer

CAUTION
It may cause 

injury.

 { At least two people are needed to lift the printer 
safely because it weighs about 37 Kg or 40 Kg.

1 Turn off your printer by pressing the 
power switch.

Reference

 { “Turning Off the Power” P.22

2 Unplug all the cables.

 { AC cord and ground wire

 { Ethernet or USB cable

3 Remove any paper from the paper trays.

4 Lift your printer and move it to a new 
location.

Transporting Your Printer

CAUTION
It may cause 

injury.

 { At least two people are needed to lift the printer 
safely because it weighs about 37 Kg or 40 Kg.

CAUTION
Possible to get 

burned.

 { The fuser unit is extremely hot. Do not touch 
it.

Note

 { The image drum (the green tube) is very delicate. Handle 
it carefully.

 { Do not expose the image drum to direct sunlight or very 
bright interior light (approximately more than 1500 lux). 
Even under the normal interior light, do not leave it for 
more than 5 minutes.

1 Turn off your printer by pressing the 
power switch.

 

Reference

 { “Turning Off the Power” P.22

2 Unplug all the cables.

 { AC cord and ground wire.

 { Ethernet or USB cable.

3 Remove any paper from the paper trays.

4 Insert your inger into the recess on 
the right side of the printer and pull the 
front cover open lever (1) to open the 
front cover (2) forward.

1

2

5 Press the top cover open button (3) and 
open the top cover (4).

CAUTION
Possible to get 

burned.

 { The fuser unit is extremely hot. Do not touch 
it.

3

4



- 132 -

Moving or Transporting Your Printer

4

4
. 

M
a
in

te
n
a
n
c
e

6 Hold the toner cartridges with both 
hands and remove them with the image 
drums. Remove all the toner cartridges 
and image drums, and place them on a lat surface.

7 Secure each toner cartridge to each 
image drum with vinyl tape (5).

5

8 Return all the toner cartridges and 
image drums to the printer.

9 Close the top cover (4) by pushing the both sides of the cover irmly.
4

10 Close the front cover (2).

Note

 { The front cover cannot be closed if the top cover is 
not closed securely.

2

11 Remove the optional additional tray unit 
from the main unit if it is installed.
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12 Protect your printer with packing 
materials.

13 Lift your printer and put it in a box.

Note

 { Use the packing materials attached to your printer when 
purchased.

 { After transporting or when setting up again, remove 
the vinyl tape used to secure the image drum and toner 
cartridges.
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5. Appendix
This chapter explains the speciications of your printer.

●{ Menu List of the Operator Panel

Checking the Printer’s Status with the Display Screen

From the <ENTER> button on the operator panel, you can check the status of your printer.

Checking the Device Status

You can check the residual life of the consumables, counter information, network settings and system 
information on the display screen.

1 Press the <ENTER> button on the 
operator panel to open the status menu.

2 Press the scroll button  to select the 
item you want to check and then press 
the <ENTER> button.
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Menu List of the Operator Panel

The function number is described on the right of each item.

Functions

Coniguration Tray Count MPTray

Tray1
Tray2

Tray3

Tray4

Supplies Life Cyan Drum

Magenta Drum

Yellow Drum

Black Drum

Cyan Toner

Magenta Toner

Yellow Toner

Black Toner

Belt

Fuser

Network Printer Name

Short Printer Name

IPv4 Address

Subnet Mask

Gateway Address

MAC Address

Network FW Version

Web Remote Version

IPv6 Address (Local)
IPv6 Address (Global)

System Serial Number

Asset Number

Lot Number

CU Version

PU Version

Total Memory

Flash Memory

SD Card

Print Information Coniguration Fn100
Network Fn101
Demo Page DEMO1

...

File List

PS Font List

PCL Font List

IBM PPR Font List

EPSON FX Font List

Usage Report Fn102 Copies

Error Log Fn103
Color Proile List

Print Secure Job Encrypted Job Fn1
Stored Job Fn2

To NEXT PAGE



- 136 -

Menu List of the Operator Panel

5

5
. 

A
p
p
e
n
d
ix

Memo

(    ) indicates the factory default setting.

Menus Tray Coniguration MPTray Conig Paper Size (A4  or Letter ) Fn90
X Dimension (210mm or 8.5inch) Fn91
Y Dimension (297mm or 11inch) Fn92
Media Type (Plain) Fn93
Media Weight (Light) Fn94
Tray Usage (Do Not Use) Fn95

Tray1 Conig Paper Size (Cassette Size) Fn10
X Dimension (210mm or 8.5inch) Fn11
Y Dimension (297mm or 11inch) Fn12
Media Type (Plain) Fn13
Media Weight (Light) Fn14
Legal Paper (Legal14) Fn15
Other Size (16K(184x260mm) ) Fn16

Tray2 Conig (When tray2 is installed) Paper Size (Cassette Size) Fn20
X Dimension (210mm or 8.5inch) Fn21
Y Dimension (297mm or 11inch) Fn22

Media Type (Plain) Fn23

Media Weight (Light) Fn24

Legal Paper (Legal14) Fn25
Other Size (16K(184x260mm) ) Fn26

Tray3 Conig (When tray3 is installed) Paper Size (Cassette Size) Fn30
X Dimension (210mm or 8.5inch) Fn31
Y Dimension (297mm or 11inch) Fn32

Media Type (Plain) Fn33

Media Weight (Light) Fn34

Legal Paper (Legal14) Fn35
Other Size (16K(184x260mm) ) Fn36

Tray4 Conig (When tray4 is installed) Paper Size (Cassette Size) Fn40
X Dimension (210mm or 8.5inch) Fn41
Y Dimension (297mm or 11inch) Fn42

Media Type (Plain) Fn43

Media Weight (Light) Fn44

Legal Paper (Legal14) Fn45
Other Size (16K(184x260mm) ) Fn46

Paper Feed (Tray1) Fn80
Auto Tray Switch (On)

Tray Sequence (Down)

Unit of Measurement (millimeter)

Duplex Last Page (Skip Blank Page)
System Adjust Power Save Time (1minute) Fn200

Sleep Time (15minutes) Fn201
Auto Power Off Time (4hours) Fn202
Clearable Warning (ONLINE)

Auto Continue (Off)

Manual Timeout (60seconds)
Wait Timeout (40seconds)
Low Toner (Continue)

Jam Recovery (On)

Error Report (Off) Fn210
Print Position Adjust X Adjust (0.00millimeter) Fn220

Y Adjust (0.00millimeter) Fn221
Duplex X Adjust (0.00millimeter) Fn222

Duplex Y Adjust (0.00millimeter) Fn223

Paper Black Setting (0) Fn230
Paper Color Setting (0) Fn231
Trans. Black Setting (0) Fn232

Trans. Color Setting (0) Fn233

SMR Setting (0) Fn234

BG Setting (0) Fn235
Drum Cleaning (Off) Fn236

To NEXT PAGE Hex Dump Fn237
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Admin Setup Network Setup TCP/IP (Enable)

IP Version (IPv4)

: You must input a password. NetBEUI (Disable)

NetBIOS over TCP (Enable)

NetWare (Disable)

EtherTalk (Disable)

Frame Type (Auto)

IP Address Set (Auto)

IPv4 Address

Subnet Mask

Gateway Address

Web (Enable)

Telnet (Disable)

FTP (Disable)

IPSec (Disable)

SNMP (Enable)

Network Scale (Normal)

Hub Link Setting (Auto Negotiate)

TCP ACK (Tray1)
Factory Defaults?

Print Setup Personality (Auto)

Copies (1)
Duplex (On)
Binding (Long Edge)

Media Check (Enable)

Resolution (600dpi)
Toner Save Toner Save Level (Off)

Mono-Print Mode (Auto) Color (All)

Default Orientation (Portrait)

Form Length (64lines)
Edit Size (Cassette Size)

X Dimension (210mm or 8.5inch)

Y Dimension (297mm or 11inch)

PS Setup Network Protocol (RAW)

Parallel Protocol (ASCII)

USB Protocol (RAW)

PCL Setup Font Source (Resident)

Font Number (I0)
Font Pitch (10.00CPI)
Font Height (12.00 point)
Symbol Set (PC-8)

A4 Print Width (78 column)
White Page Skip (Off)

CR Function (CR)

LF Function (LR)

Print Margin (Normal)

True Black (Off)

Pen Width Adjust (On)

Tray ID# Tray2 (5)
Tray3 (20)
Tray4 (21)
MPTray (4)

XPS Setup DigitalSignature (Off)

DiscardControl (Auto)

MC Mode (On)

Unzip Mode (Speed)

To NEXT PAGE White Page Skip (Off)
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IBM PPR Setup Character Pitch (10 CPI)
Font Condense (12CPI to 20CPI)
Character Set (SET-2)

Symbol Set (IBM-437)
Letter O Style (Disable)

Zero Character (Normal)

Line Pitch (6 LPI)
White Page Skip (Off)

CR Function (CR)

LF Function (LR)

Line Length (80 column)
Form Length (11.7 inch)
TOF Position (0.0 inch)
Left Margin (0.0 inch)
Fit To Letter (Disable)

Text Height (Same)

Continuous Paper Mode (Off)

EPSON FX Setup Character Pitch (10 CPI)
Character Set (SET-2)

Symbol Set (IBM-437)
Letter O Style (Disable)

Zero Character (Normal)

Line Pitch (6 LPI)
White Page Skip (Off)

CR Function (CR)

Line Length (80 column)
Form Length (11.7 inch)
TOF Position (0.0 inch)
Left Margin (0.0 inch)
Fit To Letter (Disable)

Text Height (Same)

Continuous Paper Mode (Off)

To NEXT PAGE LQ Mode (Off)
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Color Setup Ink Simulation (Off)

UCR (Low)

CMY 100% Density (Disable)
CMYK Conversion (On)

Memory Setup Receive Buffer Size (Auto)

Resource Save (Off)

Flash Memory Setup Initialize

SD Card Setup (When SD Memory Card is installed) Initialize

Resize Partition PCL (20)
Format Partition (PCL) Common (50)

PS (30)
System Setup Near Life Status (Enable)

Near Life LED (Enable)

Idle Display (Toner Gauge)

Panel Contrast (0)
Buzzer Setup Invalid Operation Volume (Off)

Error Volume (Off)

Power Setup Power Save (Enable)

Sleep (Enable)

Auto Power Off (Auto Conig)
Change Password New Password Verify Password

Settings Reset Settings

Save Settings

Restore Settings

Calibration Auto Density Mode (On)

Adjust Density Fn300
Adjust Registration Fn301
Print Tuning Pattern Fn302
Cyan Tuning Highlight (0)

Mid-Tone (0)
Dark (0)

Magenta Tuning Highlight (0)
Mid-Tone (0)
Dark (0)

Yellow Tuning Highlight (0)
Mid-Tone (0)
Dark (0)

Black Tuning Highlight (0)
Mid-Tone (0)
Dark (0)

Cyan Darkness (0) Fn310
Magenta Darkness (0) Fn311
Yellow Darkness (0) Fn312
Black Darkness (0) Fn313

Java Application …
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Boot Menu USB Setup USB (Enable)

Speed (480Mbps)
To display the [Boot Menu], 
turn on the power while 
pressing the <ENTER> 
button.

: You must input a 
password.

Soft Reset (Disable)

Ofline Receive (Disable)
Serial Number (Enable)

Security Setup (When SD Memory Card is installed) Job Limitation (Off)

Make Secure SD Card

Make Normal SD Card

Reset Cipher Key

Storage Setup Check File System (When SD Memory Card is installed)

Check All Sectors (When SD Memory Card is installed)

Enable SD Card (Yes) (When SD Memory Card is installed)

Erase SD Card (When SD Memory Card is installed)

Enable Initialization (No)

Language Setup Language Initialize

System Setup High Humid Mode (Off)

Moisture Control (Off)

Narrow Paper Speed (Slow)

Slow Print Mode (Off)

Warmup Control (Off)

Menu Lockout (Off)

Print Statistics Usage Report (Enable)

Supplies Report (Disable)

: You must input a 
password.

Reset Main Counter

Reset Supplies Counter

Change Password New Password Verify Password
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●{ Basic Steps in Windows

These are the steps for displaying the printer driver setting window from [Printer] / [Printers and Faxes] folder in Windows OS used for examples in this manual other than Windows 7.

Memo

 { The steps for Windows Server 2008 R2 are the same as for Windows 7.

 { If you have multiple printer drivers installed, the icons for each driver are displayed in the [Printer] / [Printers and Faxes] 
folder. Please follow the below steps using the drivers you want to set/check. Please follow the below steps using the printer 
drivers you want to set/check.

Displays the Property Screen

 � For Windows Vista/Windows Server 2008
1 Click [Start], and select [Control Panel] > [Printer].

2 Right-click on the OKI C831 icon, and select [Properties].

 � For Windows XP/Windows Server 2003
1 Click [Start], and select [Printers and Faxes].

2 Right-click on the OKI C831 icon, and select [Properties].

 � For Windows 2000
1 Click [Start], and select [Settings] > [Printer].

2 Right-click on the OKI C831 icon, and select [Properties].

Displays the Printer Setting Screen

 � For Windows Vista/Windows Server 2008
1 Click [Start], and select [Control Panel] > [Printer].

2 Right-click on the OKI C831 icon, and select [Printing preferences].

 � For Windows XP/Windows Server 2003
1 Click [Start], and select [Printers and Faxes].

2 Right-click on the OKI C831 icon, and select [Printing preferences].

 � For Windows 2000
1 Click [Start], and select [Settings] > [Printer].

2 Right-click on the OKI C831 icon, and select [Printing preferences].
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●{ Speciications
Model Model Number

C831/ES8431 N35100A, N35100B

C841/ES8441 N35101A, N35101B

 � General Speciications
C831/ES8431 C841/ES8441

CPU PowerPC464FP, 800 MHz

Memory Resident 256 MB

Option 256 MB/512 MB

Flash RAM NAND : 64 MB
NOR : 2 MB
Serial NOR : 512 KB

Storage Device SD memory card kit
 { Optional

16 GB

Weight 37 Kg (including consumables without a duplex unit), 
40 Kg (including consumables with a duplex unit)

Dimensions 449(W) x 552(D) x 360(H) mm

Power supply N35100A, N35101A :
110 - 127 VAC (Range 99 - 140 VAC), 50/60 Hz ± 2%

N35100B, N35101B :
220 - 240 VAC (Range 198 - 264 VAC), 50/60 Hz ± 2%

Power 
consumption

Typical 
operation

700 W

Idle 100 W

Peak 1400 W

Sleep mode N35100A, N35101A : Less than 0.7 W
N35100B, N35101B : Less than 1.0W

Power save 
mode

Less than 12 W

Off mode N35100A, N35101A : Less than 0.1 W
N35100B, N35101B : Less than 0.15 W

Interface USB 2.0 (Hi-Speed), Ethernet 10BASE-T/100BASE-TX

Display Graphics panel 60(W) x 32.6(H) mm, 128 x 64 dots

Supported OS  { Windows 7, Windows Vista, Windows Server 2008 R2, Windows Server 2008, 
Windows XP, Windows Server 2003, Windows 2000

 { Mac OS X 10.3.9-10.7
Please refer to product requirements for details.
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 � Printing Speciications
C831/ES8431 C841/ES8441

Printing method Dry electrophotographic recording method with LED (Light-emitting diode)

Emulation language PCL6 (XL3.0 and PCL5c), PostScript 3

Resident fonts PCL: 91 european fonts
PS: 80 european fonts

Resolution 600 x 600 dpi, 600 x 1200 dpi,  
600 x 600 dpi 2bit

1200 x 1200 dpi, 600 x 600 dpi

Color Yellow, Magenta, Cyan, Black

Print speed (A4) Simplex: 35 ppm
Duplex: 27 ppm

Paper size Tray 1 Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B5, B4, A6, 8K (260 x 
368 mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x 270 mm, 
184 x 260 mm)

Tray 2/3/4  
(Option)

Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B4, B5, 8K (260 x 368 
mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x 270 mm, 184 x 
260 mm)

MP Tray Legal 13/13.5/14, letter, executive, tabloid, statement, A3, A4, A5, B4, B5, A6, 
C4, C5, DL, Com-10, index card (3 x 5 inch), custom size, banner up to 52 inch, 
8K (260 x 368 mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x 
270 mm, 184 x 260 mm)

Duplex 
Printing

Legal 13/13.5/14, letter, executive, tabloid, A3, A4, A5, B4, B5, 8K (260 x 368 
mm, 270 x 390 mm, 273 x 394 mm), 16K (197 x 273 mm, 195 x 270 mm, 184 x 
260 mm), custom size (148 - 297 mm (W) x 182 - 431.8 mm (L))

Custom size  { Tray 1
105 - 297 mm (W),       148, 182 - 431.8 mm (L) 
(4.1 - 11.7 inches (W),  5.8, 7.2 - 17.0 inches (L))

 { Tray 2/3/4 (option)
148 - 297 mm (W),       182 - 431.8 mm (L)  
(5.8 - 11.7 inches (W),  7.2 - 17.0 inches (L))

 { MP tray
64 x 90 - 297 x 1321 mm (2.5 x 3.5 - 11.7 x 52 inches)

Media type Plain paper (64 g/m2 - 256 g/m2), envelopes, label.

Feeding method Automatic feeding from the tray 1, MP tray and additional tray unit (optional), 
Manual feeding from MP tray

Paper loading capacity  { Tray 1

300 sheets of Standard paper /80 g/m2, total thickness 30 mm or lower.
 { MP tray

100 sheets of Standard paper /80 g/m2 and total thickness 10 mm or lower, 10 

envelopes/ weight of 85 g/m2.
 { Additional tray unit (optional)

530 sheets of Standard paper /80 g/m2, total thickness 53 mm or lower.

Output method Face up/Face down

Paper output capacity  { Face up

100 sheets (less than 80 g/m2), 10 sheets (ultra-heavy/envelopes) 
 { Face down

250 sheets (less than 80 g/m2) 

Print guaranteed area 6.35 mm or more from the paper edge (not applicable to special media such as 
envelopes)

Print precision Print beginning:± 2 mm, paper skew:± 1 mm/100 mm, 

image expansion:± 1 mm/100 mm (80 g/m2)

Warm-up time  { From power on
32 seconds (at room temperature 25°C, rated voltage)

 { From power save mode
27 seconds (at room temperature 25°C, rated voltage)
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C831/ES8431 C841/ES8441
Operating environment  { When in operation

10 - 32°C / Relative Humidity of 20 - 80% (maximum wet bulb temperature of 
25°C, maximum dry bulb temperature of 2°C) 

 { When not in operation
0 - 43°C / Relative Humidity of 10 - 90% (maximum wet bulb temperature of 
26.8°C, maximum dry bulb temperature of 2°C) 

Conditions for the guarantee 
of print quality

 { Operating Range
Temperature 10°C, humidity 20 to 80% RH
Temperature 32°C, humidity 20 to 60% RH
Humidity 20% RH, temperature 10 to 32°C
Humidity 80% RH, temperature 10 to 27°C

 { Full-color Print Quality Assured Range
Temperature 17 to 27°C, humidity 50 to 70% RH

Consumables, Maintenance 
Unit

Toner cartridges, image drum, belt unit, fuser unit, feed roller set

 � Network Speciications
C831/ES8431 C841/ES8441

Interface Ethernet 10BASE-T/100BASE-TX

Protocol TCP/IPv4, TCP/IPv6, SMTP, POP3, HTTP, SNMPv1/v3, DHCP, DNS, LPR, Port9100, 
BOOTP, ARP, FTP, SLP, Bonjour (Rendezvous), Web Services Discovery (WSD), 
NetWare, EtherTalk, NetBEUI

Supported browsers Microsoft IE 6.0 or later, Safari 3 or later, Firefox 3.0 or later
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 � Printer Dimensions

449 mm

360 mm

760 mm
400 mm

498 mm

774 mm138 mm

138 mm

138 mm

1107 mm

255 mm 552 mm 300 mm

420 mm

TOP VIEW

SIDE VIEW

OPTION-INSTALLED VIEW (TRAY2/3/4)
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Placement Space ................. 16
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Oki contact details
Oki Systems (UK) Ltd Oki Systems (Iberica), S.A.U

C/Teide, 3
San Sebastian de los Reyes
28703, Madrid

Tel:+34 91 3431620
Fax: +34 91-3431624
Atención al cliente: 902 36 00 36
Website: www.oki.es

Oki Systèmes (France) S.A.
44-50 Av. du Général de Gaulle
94246 L'Hay les Roses
Paris

Tel:+33 01 46 15 80 00
Télécopie:+33 01 46 15 80 60
Website: www.oki.fr

OKI Systems (Magyarország) Kft.
Capital Square
Tower 2
7th Floor
H-1133 Budapest,
Váci út 76
Hungary

Telefon: +36 1 814 8000
Telefax: +36 1 814 8009
Website: www.okihu.hu

OKI Systems (Italia) S.p.A.
via Milano, 11,
20084 Lacchiarella (MI)

Tel:+39 (0) 2 900261
Fax:+39 (0) 2 90026344
Website: www.oki.it

OKI Printing Solutions
Platinium Business Park II, 3rd Floor
ul. Domaniewska 42
02-672 Warsaw
Poland

Tel:+48 22 448 65 00
Fax:+48 22 448 65 01
Website: www.oki.com.pl
E-mail: oki@oki.com.pl
Hotline: 0800 120066
E-mail: tech@oki.com.pl

Oki Systems (Ibérica) S.A.
Sucursal Portugal
Edifício Prime -
Av. Quinta Grande 53
7º C Alfragide
2614-521 Amadora
Portugal

Tel:+351 21 470 4200
Fax:+351 21 470 4201
Website:www.oki.pt
E-mail : oki@oki.pt

Oki Service
Serviço de apoio técnico ao
Cliente
Tel: 808 200 197
E-mail : okiserv@oki.pt

OKI Europe Ltd. (Russia)
Office 702, Bldg 1
Zagorodnoye shosse
117152, Moscow

Tel: +74 095 258 6065
Fax: +74 095 258 6070
e-mail: info@oki.ru
Website: www.oki.ru

Technical support:
Tel: +7 495 564 8421
e-mail: tech@oki.ru

Oki Systems (Österreich)
Campus 21
Businesszentrum Wien Sued
Liebermannstrasse A02 603
22345 Brun am Gebirge

Tel: +43 223 6677 110
Drucker Support:
+43 (0) 2236 677110-501
Fax Support:
+43 (0) 2236 677110-502
Website: www.oki.at

OKI Europe Ltd. (Ukraine)
Raisy Opkinoy Street,8
Building B, 2nd Floor,
Kiev 02002
Ukraine

Tel: +380 44 537 5288
e-mail: info@oki.ua
Website: www.oki.ua

Harman sok Duran Is Merkezi,
No:4, Kat:6,
34394, Levent
İstanbul

Tel: +90 212 279 2393
Faks: +90 212 279 2366
Web: www.oki.com.tr
www.okiprintingsolutions.com.tr

Oki Systems (Belgium)
Medialaan 24
1800 Vilvoorde

Helpdesk: 02-2574620
Fax: 02 2531848
Website: www.oki.be

AlphaLink Bulgaria Ltd.
2 Kukush Str.
Building "Antim Tower", fl. 6
1463 Sofia, Bulgaria

tel: +359 2 821 1160
fax: +359 2 821 1193
Website: http://bulgaria.oki.com

OKI Sistem ve Yazıcı Çözümleri
Tic. Ltd. Şti.

Blays House
Wick Road
Egham
Surrey
TW20 0HJ

Tel: +44 (0) 1784 274300
Fax: +44 (0) 1784 274301
http://www.oki.co.uk

Oki Systems Ireland Limited
The Square Industrial Complex
Tallaght
Dublin 24

Tel:+353 (0) 1 4049590
Fax:+353 (0)1 4049591
http://www.oki.ie

Oki Systems Ireland Limited -
Northern Ireland
19 Ferndale Avenue
Glengormley
BT36 5AL
Northern Ireland

Tel:+44 (0) 7767 271447
Fax:+44 (0) 1 404 9520
http://www.oki.ie

Technical Support for all Ireland:
Tel:+353 1 4049570
Fax:+353 1 4049555
E-mail: tech.support@oki.ie

OKI Systems (Czech and Slovak),
s.r.o.
IBC – Pobřežní 3
186 00 Praha 8
Czech Republic

Tel: +420 224 890158
Fax:+420 22 232 6621
Website: www.oki.cz, www.oki.sk

Oki Systems (Deutschland) GmbH
Hansaallee 187
40549 Düsseldorf

Tel: 01805/6544357**
01805/OKIHELP**

Fax: +49 (0) 211 59 33 45
Website:
www.okiprintingsolutions.de
info@oki.de

**0,14€/Minute aus dem dt. Festnetz
der T-Com (Stand 11.2008)

CPI S.A1 Rafailidou str.
177 78 Tavros
Athens
Greece

Tel: +30 210 48 05 800
Fax:+30 210 48 05 801
EMail:sales@cpi.gr

Διανομέας των συστημάτων OKI
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OKI Printing Solutions
Herstedøstervej 27
2620 Albertslund
Danmark

Adm.: +45 43 66 65 00
Hotline: +45 43 66 65 40
Salg: +45 43 66 65 30
Fax: +45 43 66 65 90
Website: www.oki.dk

Oki Systems (Finland) Oy
Polaris Capella
Vänrikinkuja 3
02600 Espoo

Tel: +358 (0) 207 900 800
Fax: +358 (0) 207 900 809
Website: www.oki.fi

Oki Systems (Holland) b.v.
Neptunustraat 27-29
2132 JA Hoofddorp

Helpdesk: 0800 5667654
Tel:+31 (0) 23 55 63 740
Fax:+31 (0) 23 55 63 750
Website: www.oki.nl

Oki Systems (Norway) AS
Tevlingveien 23
N-1081 Oslo

Tel:+47 (0) 63 89 36 00
Telefax:+47 (0) 63 89 36 01
Ordrefax:+47 (0) 63 89 36 02
Website: www.oki.no

General Systems S.R.L. 
(Romania)
Sos. Bucuresti-Ploiesti Nr. 135.
Bucharest 1
Romania

Tel: +40 21 303 3138
Fax: +40 21303 3150
Website: http://romania.oki.com

Var vänlig kontakta din Återförsäljare
i första hand, för konsultation. I 
andra hand kontakta

Oki Systems (Sweden) AB
Borgafjordsgatan 7
Box 1191
164 26 Kista

Tel. +46 (0) 8 634 37 00
e-mail:
info@oki.se för allmänna frågor om 
Oki produkter

support@oki.se för teknisk support 
gällandes Oki produkter

Vardagar: 08.30 - 12.00,
13.00 - 16.00
Website: www.oki.se

Oki Systems (Schweiz)
Baslerstrasse 15
CH-4310 Rheinfelden

Support deutsch +41 61 827 94 81
Support français +41 61 827 94 82
Support italiano +41 061 827 9473
Tel: +41 61 827 9494
Website: www.oki.ch

Oki Data Americas Inc.(United 
States • États-Unis)
2000 Bishops Gate Blvd.
Mt. Laurel, NJ 08054
USA

Tel: 1-800-654-3282
Fax: 1-856-222-5247
http://WWW.OKIPRINTINGSOLUTIONS.COM
http://my.okidata.com

Oki Data Americas Inc.(Canada • 
Canadá)
4140 B Sladeview Crescent Units 7&8
Mississauga, Ontario
Canada L5L 6A1

Tél: 1-905-608-5000
Téléc: 1-905-608-5040
http://WWW.OKIPRINTINGSOLUTIONS.COM

WWW.OKIPRINTINGSOLUTIONS.COM

Oki Data Americas Inc.(América 
Latina (OTRO))
2000 Bishops Gate Blvd.
Mt. Laurel, NJ 08054
USA

Tel (Español): 1-856-222-7496
1-856-222-5276

Fax: 1-856-222-5260
Email: LASatisfaction@okidata.com

Oki Data de Mexico, S.A. de C.V.
Mariano Escobedo #748, Piso 8
Col. Nueva Anzures
C.P. 11590, México, D.F.

Tel: 52-555-263-8780
Fax: 52-555-250-3501
http://

Oki Data do Brasil, Ltda.
Rua Avenida Alfrefo Egidio de souza Aranha 
100-4° andar-Bloco C Chacara Santo Antonio
Sao Paulo, Brazil 04726-170

Tel: 55-11-3444-6747 (Grande São 
Paulo) 
0800-11-5577 (Demais 
localidades)

Fax: 5511-3444-3501
e-mail: okiserv@okidata.com.br
http://WWW.OKIPRINTINGSOLUTIONS.COM

Oki Data (Singapore) Pte. Ltd.
438A Alexandra Road #02-11/12,
Lobby 3, Alexandra Technopark
Singapore(119967)

Tel:(65) 6221 3722
Fax:(65) 6594 0609
http://www.okidata.com.sg

Oki Systems (Thailand) Ltd.
1168/81-82 Lumpini Tower,
27th Floor Rama IV Road
Tungmahamek, Sathorn
Bangkok 10120

Tel:(662) 679 9235
Fax:(662) 679 9243/245
http://www.okisysthai.com

Oki Systems (Hong Kong) Ltd.
Suite 1908, 19/F, Tower 3,
China Hong Kong City
33 Canton Road, TsimShaTsui,
Kowloon, Hong Kong

Tel: (852) 3543 9288
Fax: (852) 3549 6040
http://

Oki Data(Australia) Pty Ltd.
146 O'Riordan Street Mascot,
NSW 2020, Australia

Tel: +61 (02) 9667 7240
Fax: +61 (02) 9667 7333
http://www.oki.com.au

Comworth Systems Ltd.
8 Antares Place Mairangi Bay,
Auckland, New Zealand

Tel:(64) 9 477 0500
Fax:(64) 9 477 0549
http://www.comworth.co.nz

Oki Data(S) P Ltd. Malaysia Rep 
Office
Suite 21.03, 21st Floor Menara IGB,
Mid Valley City,
Lingkaran Syed Pura 59200,
Kuala Lumpur, Malaysia

Tel: (60) 3 2287 1177
Fax: (60) 3 2287 1166

www.okiprintingsolutions.com.hk
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